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Copyright

The software described in this document is supplied under a license agreement. 
The software may be used or copied only in accordance with the terms of this
agreement. It is against the law to copy the software on any medium except as
specifically allowed in the license agreement. 
The purchaser may make only one copy of the software for backup purposes.

No part of this manual may be photocopied or transmitted in any form or by any
means, electronic or mechanical including photocopying, recording or information
storage and retrieval systems, for any purpose other than the purchaser’s personal
use, without the expressly written consent of Samsung Electronics Co., Ltd.

Information in this document is subject to change without notice and does not 
represent a commitment on the part of Samsung Electronics Co., Ltd. Samsung
Electronics Co., Ltd. or its distributors can in no circumstances be held responsible
for any prejudice, whether direct or indirect, resulting from the use of the software
or the documentation.

August 2000

Trademark Notices

◆ Copyright 2000 SAMSUNG Electronics Co., Ltd. All rights reserved.

◆ All other brand or product names are trademarks or registered trademarks of their

respective companies or organizations.
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◆ Centronics is a registered trademark of Centronics Data Computer Corporation.

◆ HP, PCL, PCL 6 are registered trademarks of Hewlett-Packard Company.

◆ IBM, IBM PC, XT, AT, PS/2 are registered trademarks of International Business

Machines Corporation.
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trademarks of Apple Computer Inc.

◆ Microsoft, MS-windows, MS-DOS are registered trademarks of Microsoft Corporation.
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Environmental and Safety Consideration

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR,

chapter 1 Subchapter J for Class I(1) laser products, and elsewhere is certified as a

Class I laser product conforming to the requirements of IEC 825.

Class I laser products are not considered to be hazardous. The laser system and printer

are designed so there is never any human access to laser radiation above a Class I level

during normal operation, user maintenance, or prescribed service condition.

CAUTION

Never operate or service the printer with the protective cover removed 

from Laser/Scanner assembly. The reflected beam, although invisible, 

can damage your eyes.

CLASS 1 LASER PRODUCT 
LASER KLASSE 1
LUOKAN 1 LASERLAITE
APPAREIL A LASER DE
CLASSE 1 
TO IEC 825

Class 1 Laser Statement Label

’

Laser safety statement



6

CAUTION - INVISIBLE LASER RADIATION WHEN THIS COVER IS

OPEN. DO NOT OPEN THIS COVER.

VORSICHT     - UNSICHTBARE LASERSTRAHLUNG, WENN ABDECKUNG

GEÖFFNET. NICHT DEM STRAHL AUSSETZEN.

ATTENTION    - RAYONNEMENT LASER INVISIBLE EN CAS D’OUVERTURE. 

DANGEREUSE AU FAISCEAU.

ATTENZIONE     -RADIAZIONE LASER INVISIBILE IN CASO DIAPERTURA.

EVITARE L’ESPOSIZIONE AL FASCIO.

PRECAUCION   -RADIACION LASER IVISIBLE CUANDO SE ABRE. 

EVITAR EXPONERSE AL RAYO.

ADVARSEL     - USYNLIG LASERSTRÅLNING VED ÅBNING NÅR SIKKERHEDSBRYDERE 

ER UDE AF FUNKTION UNDGÅ UDSAETTELSE FOR STRÅLNING.

ADVARSER     - USYNLIG LASERSTRÅLNING NÅR DEKSEL ÅPNES. STIRR IKKE INN I

STRÅLEN. UNNGÅ EKSPONERING FOR STRÅLEN.

VARNING       - OSYNLIG LASERSTRÅLNING NÄR DENNA DEL ÄR ÖPPAND OCH

SPÄRREN ÅR URKOPPLAD. BETRAKTA EJ STRÅLEN STRÅLEN AR FARLIG.

VARO            - AVATTAESSA JA SUOJALUKITUS OHITETTAESSA OLET ALTTIINA

NÄKYMÄTTÖMÄLLE LASERSÄTEILYLLE ÄLÄ KATSO SÄTEESEEN.

Laser caution label

Environmental and Safety Consideration
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Ozone Safety

Power Saver

During normal operation, the Samsung ML-7300 Series printer
produces ozone. The ozone produced does not present a hazard
to the operator. However, it is advisable that the machine be
operated in a well ventilated area.

If you need additional information about ozone, please contact
your nearest Samsung dealer.

This printer contains advanced energy conservation technology
that reduces power consumption when it is not in active use.

When the printer does not receive data for an extended period of
time, power consumption is automatically lowered. 

The energy star emblem does not represent EPA endorsement of
any product or service.
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This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC rules. 
These limits are designed to provide reasonable protection against harmful
interference in a residential installation. 
This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

•  Re-orient or relocate the receiving antenna.
•  Increase the separation between the equipment and receiver.
•  Connect the equipment into an outlet on a circuit different from that to which

the receiver is connected.
•  Consult the dealer or an experienced radio/TV technician for help.

Shielded interface cables and I/O cords must be used for this equipment to
comply with the relevant FCC regulations.

Changes or modifications not expressly approved in writing by Samsung may
void the user’s authority to operate this equipment.

FCC Compliance

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations of ICES-003.

Cet appareil numerigue de la Classe B respecte toutes les exigences du
Reglement ICES-003 sur le Materiel brouilleur du Canada.

IC COMPLIANCE NOTICE

Environmental and Safety Consideration



Environmental and Safety Consideration

9

Safety and Regulatory Listing for this printer.

PRODUCT SAFETY
USA & CANADA  Evaluated by UL according to UL 1950

and CSA C22.2 No. 950 for C-UL
EEC(Europe)  IEC 60950/EN 60950(TUV GS Certification)
CB IEC 60950

LASER SAFETY
EEC(Europe) HD 194. & EN 60825
USA 21 CFR, Chapter 1, Subchapter J(CDRH Certified)

Safety information

We,
SAMSUNG ELECTRONICS CO.,LTD
#259, Gong Dan-Dong, Gumi-City, Kyung Buk, Korea

declare sole responsibility that the 

ML-7300, ML-7300N Laser Printer

meets the intent of Directive 89/336/EEC for Electromagnetic Compatibility and 
Low Voltage Directive 73/23/EEC.
Compliance was demonstrated to the following specifications as listed in the official 
journal of the European Communities:

Electro Magnetic Interference (EMI):
EN 55022  Radiated, Class B
EN 55022  Conducted, Class B
EN 61000-3-2  Power Harmonics
EN 61000-3-3  Voltage Fluctuations and Flicker

EN 55024 - Electro Mangnetic Susceptibility (EMS)
EN 61000-4-2  Electrostatic Discharge
EN 61000-4-3  RF Electromagnetic Field
EN 61000-4-4  Fast Transients
EN 61000-4-5  Surges
EN 61000-4-6  RF Common Mode
EN 61000-4-8  Power Frequency Magnetic Field
EN 61000-4-11 Voltage Dips and Interruptions

EN 60950-Safety

EC Declaration of Conformity



Environmental and Safety Consideration

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp
plug and 13 amp fuse. When you change or examine the fuse, you must re-fit
the correct 13 amp fuse. You then need to replace the fuse cover. If you have
lost the fuse cover, do not use the plug until you get another fuse cover from
the people who sold you the machine.

The 13 amp plug is the most widely used type in the UK. However, some build-
ings (mainly old ones) do not have normal 13 amp plug sockets. You need to
buy a suitable plug adaptor. Do not remove the moulded plug.

Warning
If you cut off the moulded plug, get rid of it 
straight away. You cannot rewire the plug or 
you may get an electric shock if you put it into a 
socket.

Important warning: You must earth this machine.

The wires in the mains lead use the following colour code:

Green and Yellow : Earth
Blue : Neutral
Brown : Live

If the wires in the mains lead do not match the colours marked in your plug, do
the following:

You must connect the blue wire to the pin which is marked with the letter ‘N’ or
coloured black.

You must connect the brown wire to the pin which is marked with the letter ‘L’
or coloured red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

Replacing the fitted plug (UK Only)

10



IntroductionIntroduction
Congratulations on the purchase of your 
ML-7300 series printer! This chapter provides information
on the following topics:

◆ Safety Precautions

◆ Features and Model Descriptions

◆ Printer Components

11



INTRODUCTION 1.1

Before using the printer, please read the instructions in this guide carefully
and put the guide in a safe place close to the printer, so that it is available
when you need it later. Please take the following precautions when using
and maintaining your printer.

● Unplug the printer before cleaning it. Do Not use any liquid or aerosol
cleaners. Simply use a damp cloth. Refer to the page of this guide for
further details.

● Do Not place the printer on an unstable surface or close to a radiator or
source of heat.

● Take care not to block or cover the ventilation holes on the side of the
printer. Do Not insert any object in these holes.

● Check that the electrical power source to which you wish to connect the
printer complies with the electrical specifications of this printer : 
(100 ~ 240V) - Power cord may differ from one country to another.

● Connect all your computer equipment, including the printer to a power
point with earthing device. Avoid plugging your printer into the same
power point as equipment likely to cause voltage variations, such as a
photocopying machine or an air conditioner.

● Check regularly that the power cable is in good condition and is not
damaged in any way.

● If you use an extension cord, check that total intensity of all equipment
connected to it does not exceed the maximum intensity allowed for the
extention cord. Check that the total intensity of the equipment connected
to the same power point does not exceed 15 amps.

● Unless otherwise indicated in this guide, do not attempt to repair the
printer yourself. Should you detect a fault, return your printer to an
authorized service center or your dealer.

● Systematically return your printer to an authorised service center or your
local dealer if one of the following situations occurs :
- The power cord or plug is damaged.
- A liquid has been spilled on and/or in the printer.
- The printer has fallen or been dropped or the bodywork is damaged in

any way.
- The printer is not operating correctly or you have noticed a significant

drop in the quality of the printing. 

Safety Precautions
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Your new Laser Printer is designed for use in an
office environment, providing such advantages as :
● Printing on both sides of paper
● High-quality, high-speed text and graphics printing
● Vast choice of paper types and sizes
● Full operating status and error messages on

operator panel display
● On-screen feedback of the printing status
● Various printer menus

This Laser Printer provides the following main features.
● Built in Duplex function which allows printing on both 

sides of the paper
● Printing speeds of 21PPM(Pages Per Minute) for 

Letter-size paper
● High-quality printing at a maximum resolution of 1200 DPI
● Automatic paper feed with a capacity of up to 500 sheets
● Wide range of paper sizes and weights
● Expandable design

- 500-sheet universal paper Tray
- Memory(up to 208 MB)
- Connectors for optional RS-232C/LocalTalk Card and 

Network Interface Card
- Connector for optional Infrared Adapter

Features and Model Descriptions

Your new Printer

Printer Information

Main Features

ML-7300 ● The ML-7300 comes equipped with 16MB

RAM and one 500-sheet Tray1 as

standard.

ML-7300N ● The ML-7300N is equipped with network

card (PortThru) as standard. 

Install the network printer driver

(SyncThru) for network printing.



The following illustration shows the front view of your printer and 
indicates the various main elements.

Top output bin

Operator panel

Print prevention sensor
(It prevents the printer 
from printing when 250 
sheets of paper are piled 
up on the top output bin).

Paper level 
indicator

Tray1
(500-sheet, closed)

Top cover

Multi-Purpose tray
(100-sheet, with extension)

Power switch

The following illustration shows the rear view of your printer 
and indicates the various main elements.

Rear cover

Power
connector

Parallel interface 
connector

LSU cleaner
(When the top 
cover is opened)

Printer Components

Front View

Rear View

INTRODUCTION 1.3



Setting Up    
Your Printer
Setting Up    
Your Printer

This chapter provides step by step information
on setting up your printer.
Topics included in this chapter are:

• STEP 1: Unpacking Your Printer

• STEP 2: Installing Toner Cartridge

• STEP 3: Load Paper

• STEP 4: Connecting the Parallel Cable

• STEP 5: Connecting the AC Power Cord

• STEP 6: Testing the Printer!

• STEP 7: Setting Up the Printer Driver

22



Notes: • If you find that any of the above items are missing or damaged, 
contact your local dealer.

• A printer cable is not included in the package items.
• Cable specifications 

- The parallel cable should be compatible with the centronics®

parallel interface and IEEE standard 1284.
• * Power cord may differ from one country to another.

When you start unpacking the box of your printer, you will find the following
items in addition to your printer.

SETTING UP YOUR PRINTER 2.1

Power cord*

Toner cartridge CD-ROM Disk

This manual

Items Supplied

Unpacking Your Printer



SETTING UP YOUR PRINTER2.2

During the storage and transport of your printer, adhesive tape is used to block
some of the elements that may move or open unexpectedly and consequently
be damaged.

1 Before connecting up your printer
and starting to use it, you must
remove all the adhesive tapes, 
as illustrated in the figure below.

2 Slide the tray out of the printer. 
Remove the packaging material
from the tray.

Preparation

Unpacking Your Printer



SETTING UP YOUR PRINTER 2.3

Installing Toner Cartridge

To install a toner cartridge in your printer proceed as follows.

1 Remove the toner cartridge from
its packaging.

2 Open the top cover of the printer
by pressing the button on the
right side of the printer.

Notes: • Do not remove the cartridge
from its packaging until you
are ready to use it. 

• Do not expose the cartridge
to light, it could damage the
cartridge permanently.



SETTING UP YOUR PRINTER2.4

Installing Toner Cartridge

3 Rotate the cartridge and gently
shake it from side to side to 
distribute the toner evenly inside
the cartridge.

4 Position the cartridge as shown
with the arrow pointing into the
printer. Slide the cartridge into the
printer as far as it will go.

Notes: If toner gets on your clothing, wipe it off with a dry cloth and wash clothing
in cold water. When printing text at 5% coverage, a toner cartridge lasts an
average of 10,000pages in simplex mode.

5 Close the top cover.



SETTING UP YOUR PRINTER 2.5

Load Paper

To load paper in the tray, proceed as follows.

1 Pull the Tray1 completely out of
the printer.

2 Squeeze the back of the rear
paper guide and slide it to the
desired paper size until it clicks
into place.
The paper sizes are indicated on
the bottom of the tray1.

Rear paper
guide



SETTING UP YOUR PRINTER2.6

3 Lift the rear right guide and slide
it to match the width of the paper.
The paper sizes are indicated on
the bottom of the tray.

4 Squeeze the width guide and slide
it to the far right side of the tray.

5 Place the paper against the rear
paper guide as shown.

Printing side(down)

Paper Limit Line

Width guide Rear right guide

Notes: If the tray is not properly adjusted, the printer might display an error
message or paper might jam.

Notes: • Do not fold or crease the paper.
• Place the paper with the recommended print side face down.
• Don’t exceed the paper limit line indicated on the tray.

Load Paper



SETTING UP YOUR PRINTER 2.7

6 Squeeze the width guide and slide
it to the left until it lightly rests
against the edge of the paper.

7 Make sure the paper is under 
the tab on the tray.

8 Gently slide the tray back into the 
printer. The printer automatically 
senses the size of paper loaded 
if the tray1 is adjusted correctly.

Load Paper

Notes: If jam 0 often occurs when 24lb
letter, legal or folio size paper is used,
push down the lever on the left side of the
tray as shown in the figure to ensure
proper paper feeding.



SETTING UP YOUR PRINTER2.8

To print from computer software, you need to connect your printer to your
computer with a parallel interface cable.

The parallel cable should be compatible with the Centronics R parallel interface 
and IEEE standard 1284. If you purchase a parallel cable, ensure that it :
• Is compatible with Centronics interface.
• Supports bi-directional communications(IEEE standard 1284).
• Is shielded.
• Has the appropriate connector : 

- 25 pin D-Sub connector on the computer side.
- Amphenol 36 connector on the printer side.

Connecting the Parallel Cable

Cable Specifications (Not provided)

Connecting the Parallel Cable

2 Plug the appropriate end of the
parallel cable into the connector on
the rear of the printer.

To connect the printer to your computer use a parallel cable and 
proceed as follows.

1 Check that both the printer and the computer to which it is to be connected
are powered off and disconnected from the power point.



SETTING UP YOUR PRINTER 2.9

Connecting the Parallel Cable

3 Push the clip at each end of the 
connector down into the notches
on the plug as shown.

4 Plug the other end of the cable
into the appropriate parallel 
connector on your computer and
tighten the screws.

MIDI/GAME PHONE LINELINE
OUT

LINE
IN
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Connecting the AC Power Cord

To connect the printer to a power point, proceed as follows.

1 Plug the appropriate end of the
supplied power cable to the 
connector on the rear of the 
printer.

2 Plug the other end into a suitable 
power point.

• Power cord may differ from
one country to another.

3 Power the printer on by pressing
the power on/off button.

Result: You will hear some movement inside the printer. 
The printer enters the Ready state.



SETTING UP YOUR PRINTER 2.11

Testing the Printer!

1 Make sure that the READY status message
appears on the display.

2 Press On Line.

3 Press Menu > or < Menu to enter the menus.

4 Press Menu > or < Menu one or more times until
the TEST MENU message is displayed.

5 Press Item> or <Item one or more times until
the SELFTEST message is displayed.

Print a configuration page to make sure the printer is operating correctly.

6 Press Enter to print.

Result: The OFFLINE message appears on the display
and the printer is off-line.

Notes: • The message ‘PRINTING PCL6’ appears and remains 
on the display until the page prints.

• The printer returns to the Ready state after printing.



SETTING UP YOUR PRINTER2.12

Setting Up the Printer Driver

The printer drivers provided on the CD must be installed to take full 
advantage of the printer’s features.
Printer drivers access the printer features and allow the computer to
communicate with the printer.

If you install the printer driver using the CD, PCL 6 is installed.
The CD includes the following printer drivers.
• PCL 6

- You can use the PCL 6 driver in Windows 95, Windows 98, Windows NT 4.0
and Windows 2000. 
The PCL6 driver supports Watermark, Overlay, N-Up and Poster printing.

• Postscript.
• Font Navigator.
• Linux Driver.

Notes: • You cannot use PostScript in Windows 3.1. 
• PCL 6 is the combination of the PCL 5e driver and the new PCLXL printer

language.



SETTING UP YOUR PRINTER 2.13

Hardware Requirements

To install and run the PCL printer driver, you must have the following minimum
hardware configuration.
•  Windows 95 or Windows 98

- PC-compatible 486 computer or better.
- 32MB RAM 
- 200MB available hard-disk space.

•  Windows NT 4.0 or Windows 2000
- PC-compatible pentium 133MHz computer or better.
- 64MB RAM 
- 650MB available hard-disk space.

•  CD-ROM Drive.

Software Requirements

To install and run the printer driver, you must be running one of the 
following platforms. 
•  Windows 95, Windows 98, Windows NT 4.0, Windows 2000.
•  Macintosh System 7.5 or later.

Install Procedure

To install the printer driver on your hard disk, make backup copies of the print
driver CD. Keep the original CD in a safe place and use the copies.

Notes: I do not have a CD-ROM driver
If you have access to another computer with a CD-ROM drive, you can use 
the Make diskette utility in Windows to create the disks you need for the 
installation. Go to Appendix E, “Installing Software form Diskettes”

Installing the Driver

Setting Up the Printer Driver
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Setting Up the Printer Driver

1 Place the CD-ROM in the CD-ROM drive. Install will start
automatically.

If the CD-ROM drive does not automatically run:

Select Run from the Start menu, and type x:\cdsetup.exe
in the Open box (where x is the drive letter for the CD-ROM
drive), and then click OK.

Installing the Printer Software from the CD-ROM

Notes: If the New
Hardware Found box
appears during the 
installation procedure, 
click the  x  in the upper
right corner of the box, 
or click Cancel.

SA
MSUNG ML-7300

2 When the opening screen appears, select the appropriate
language.

3 Click Install the Samsung Software-I on your PC.

4 Follow the instructions on the screen to complete
the installation.
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Setting Up the Printer Driver

An uninstall utility is supplied with the printer driver to enable you to 
remove the driver and all associated files from your hard disk, if so required.
To uninstall the driver, proceed as follows.

Select Start ➔ Programs ➔ Samsung ML-7300 ➔ Samsung ML-7300
Driver uninstall from the windows task bar.
● The PCL 6 driver is removed from your hard disk.

Notes:  To Install Shared Win 95/98 Printer Driver from NT Server to Client PC
1 Select Sharing in Properties of the printer driver.

2 Select Windows 95 in Alternate Drivers.

3 Type D:\7300\XX\pcl\pcl6\win9x
(Where “D” is your CD-ROM drive letter and XX is the language code*, 
i.e. eng for English).

4 Install the network printer in the client PC.
* Refer to “language code” (page 2.17) for language codes.

Uninstalling the Printer Driver
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Setting Up the Printer Driver

Font Navigator is a font manager for Windows 95/98, Windows NT(4.0) 
and Windows 2000. It gives a quick and easy way to find fonts, install those
fonts, and view and print font samples. 

Installing the Font Navigator (FontNav)

1 Place the CD-ROM in the CD-ROM drive. Install will start
automatically.

If the CD-ROM drive does not automatically run:

Select Run from the Start menu, and type x:\cdsetup.exe
in the Open box (where x is the drive letter for the CD-ROM
drive), and then click OK.

Notes: If the New
Hardware Found box
appears during the 
installation procedure, 
click the  x  in the upper
right corner of the box, 
or click Cancel.

SA
MSUNG ML-7300

2 When the opening screen appears, select the appropriate
language.

3 Click Install the Bonus Software on your PC.

4 Follow the instructions on the screen to complete
the installation.
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Setting Up the Printer Driver

Language Codes

Eng English

Deu German

Frn French

Esn Spanish

Ita Italian

Kor Korean

Codes Language

2.17



Using 
Operator 
Panel

Using 
Operator
Panel

This chapter describes how to use the printer’s operator
panel. It provides information on the following topics:

◆ Operator Panel Buttons

◆ Changing Printer Setting

◆ Overview of Printer Menu

◆ PRINTING MENU

◆ CONFIG MENU

◆ JOB MENU

◆ TEST MENU

◆ PCL MENU

◆ I/O MENU

◆ PS3 MENU

◆ NETWORK MENU

33



USING OPERATOR PANEL 3.1

The operator panel, on the front right side
of your printer, has a 2-line LCD(Liquid
Crystal Display) and five buttons.

Operator Panel
Display

Operator Panel Buttons

LCD panel

Light Color

Green

Orange

Light State

On

Off

Blinking

On

Blinking

The Printer IS...

Online

Offline

Processing information.

In Non-recoverable error state
• Solve the problems for the

error message, by going
through check lists and tests.

In recoverable error state.
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A number of menus are available to make it easy for you to change printer settings.

Some menus are displayed only if a specific option is installed in the printer.

When you select a new setting from the operator panel, the asterisk(❊ ) moves

next to the selected setting to identify it as the current user default setting.

Use the five operator panel buttons to open a menu, scroll through a list of values, 
change printer settings, and respond to printer messages. 
The following table describes the functions of each button.

Operator Panel Buttons

Notes: Changes made from a software application override the user default 
settings made from the printer operator panel.

Using Panel Buttons

Button

On Line/Continue

Enter/Cancel

Function

• Places the printer either online or offline.
• Allows the printer, to continue printing when the

printer is in recoverable error state.

• Cancels the print job that the printer is processing
when the printer is online.

• Saves the selected value for that item when the
printer is offline.

Menu • Cycles through the operator panel menus.

Item • Cycles through the selected menu’s items.

Value • Cycles through the selected menu item’s values.

Operator Panel Menus
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To change an operator panel setting, proceed as follows.

A value can be :

• A phrase or word that describes a setting.

• A numerical value that you can increase or decrease.

• An On or Off setting.

1 Make sure the ‘READY’ message appears on the display.

2 Press On Line.

3 Press Menu until the menu you need appears on the display.

4 Press Item until the menu item you need appears on the display.

5 Press Value until the setting you need appears on the display. 

6 Press Enter to save the selection.

Changing Printer Setting

Result: The ‘OFFLINE’ message appears on the display and the
printer is off-line.

Result : An asterisk(❊ ) appears beside the current user default 
setting for that menu item.
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Some menus are displayed only if a required option is installed. 
They are as follows.

Overview of Printer Menu

PAPER

MP SIZE

COPIES

ORIENT

TRAY

T-MARGIN

L-MARGIN

DUPLEX

AUTO CR

WIDE A4

QUALITY

PRINTING
MENU

EMUL

SWITCH

LOCKTRAY

PWR SAVE

AUTOCONT

ECONO

JAM RECV

TONERLOW

CONFIG 
MENU

SRT MODE
TIMEOUT
DENSITY
PAP.TYPE
MENU CLR
SMET 
DUP.TOP
DUP.LEFT
S-BIND
L-BIND
FUSER CLEAN

JOB 
MENU

SELFTEST

DEMOPAGE

TEST 
MENU

FONTLIST

TYPEFACE

SYMBOL

LINES

PITCH 

PT.SIZE

COURIER

PCL 
MENU

RESET NIC

CFG NET

TCP/IP

CFG TCP

DHCP

CFG ADRS

IP BYTE
1, 2, 3, 4

SM BYTE
1, 2, 3, 4

GW BYTE
1, 2, 3, 4

BOOTP

RARP

LPD

APL TALK

NETWORK MENU
If the Network card(PortThru)

is installed in your printer

NETWARE

CFG NWAR

AUTO

EN_8023

EN_II

EN_8022

EN_SNAP

UPDATE

BOOT SVR

SV-IP B1

SV-IP B2

SV-IP B3

SV-IP B4

FACTORY DEFAULT

PRINT NET CFG

FONTLIST

PS.ERROR

PS 3 MENUI/O MENU
If the serial/LocalTalk option

card is installed in your printer

BAUDRATE

ROBU.XON
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Use the PRINTING MENU to define all settings relating to printer input and
output, as well as the specific print materials you are using with your printer.

Item

PAPER

MP SIZE

Values and Functions

If the TRAY menu is AUTO, MP, MANUAL

A4(country specific), LEGAL, Letter(country specific), EXE,

JIS B5, ISO B5, COM-10, MONARCH, DL, C5, POST A6, C6,

FOLIO, A5, STS, A6

If the TRAY menu is 1ST

A4(country specific), LEGAL, Letter(country specific), EXE,

JIS B5, ISO B5, FOLIO

If the TRAY menu is OPT

A4(country specific), LEGAL, Letter(country specific), EXE,

JIS B5, ISO B5, COM-10, MONARCH, DL, C5, FOLIO

If the DUPLEX menu is not OFF(SHORT or LONG)

A4(country specific), LEGAL, Letter(country specific), FOLIO

If the DUPLEX menu is OFF

A4(country specific), LEGAL, Letter(country specific), EXE,

JIS B5,ISO B5, COM-10, MONARCH, DL, C5, 

POST A6, C6, FOLIO, A5, STS, A6

If the DUPLEX menu is not OFF

(SHORT or LONG)

A4(country specific), LEGAL, Letter(country specific), FOLIO

Notes: The PAPER SIZE setting identifies the default formatting size for each tray.

It is important to select the correct paper size from the menu when using

trays.

PRINTING MENU
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PRINTING MENU

Item

COPIES

ORIENT

Values and Functions

1 to 999 (1; Factory Default)

The COPIES setting determines the number of copies

printed for each page. The printer does not automatically

collate the copies. For example, if you send three pages to

print and set Copies to 2, the printer prints page1, page 1,

page 2, page 2, page 3, page 3.

P : Portrait (Factory Default)
L : Landscape

The ORIENT setting determines how the 
printing is oriented on the page.

P(Portrait) means the printing is parallel to the 
short edge of  the paper.

L(Landscape) means the printing is parallel to 
the long edge of the paper.

LandscapePortrait 



AUTO(Factory Default)

1ST

MP

OPT(If the optional cassette is installed)

MANUAL

The TRAY setting identifies the default paper tray.

1ST means that the printer feeds print material from Tray 
unless it is empty or opened.

MP means that the printer feeds print material
from Multi-Purpose tray unless it is empty or closed.

Use the MANUAL selection when manually feeding

envelopes or other print material through the 

Multi-Purpose tray. 

OPT is available only if the optional tray 2 is installed. 
See ‘Optional Tray 2’ on page F.17. 

Auto means that the printer feeds print material from the other

tray when one tray is empty. If you are using the same size

and type of print material in all the trays, the trays are

automatically linked.

0.0” ~ 9.9”

The T-MARGIN menu item lets you select the top margin of 
the print materials.

USING OPERATOR PANEL 3.7

PRINTING MENU

TRAY

T-MARGIN

Item Values and Functions



USING OPERATOR PANEL3.8

PRINTING MENU

L-MARGIN

DUPLEX

0.0”~ 9.9”

The L-MARGIN menu item lets you select the 
left margin of the print materials.

AUTO CR LF(Factory Default)

LF + CR 

The AUTO CR setting determines if the printer 
automatically performs carriage return after a line feed
control command.

WIDE A4 OFF (default)
ON

The WIDE A4 setting determines if the printer can print 
80 columns in A4 size.

QUALITY 300

600 (Factory Default)

1200

QUALITY setting determines the print resolution while 
printing the page.

OFF (Factory Default)

LONG

SHORT

The printer can automatically print on both sides of paper.

Use the OFF selection when printing on one side of a

sheet of paper. For more information, see page 5.13.

Long

Short

Item Values and Functions
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Use the CONFIG MENU to configure a variety of printer features. 

EMUL

PWR SAVE

AUTO (Factory Default)

PCL

PS3

HEXDUMP

You can select the emulation for printing a document.

AUTOCONT ON (Factory Default)

OFF

The AUTOCONT setting determines whether the printer 

continues printing after it detects paper mismatch. 

If an error occurs and AUTOCONT is set to OFF, 

the printer stops and waits for operator intervention. 

If the Continue button on the operator panel is pressed, 

the printer continues printing regardless of paper mis-

match. When AUTOCONT is set to ON, the printer auto-

matically resumes processing. 

120

15

30 (Factory Default)

45

60

The PWR SAVE menu item lets you reduce power 

usage when the printer is idle. The PWR SAVE setting

determines the length of time (in minutes) the printer

waits after a job is printed before it goes to a reduced

power state. 

CONFIG MENU

Item Values and Functions
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CONFIG MENU

ECONO

JAM RECV

OFF (Factory Default)

ON

The ECONO setting helps conserve the toner cartridge 

by controlling how much toner the printer uses for a print

job. 

Select OFF if toner conservation is not a concern.

But this setting may affect the print quality of your job. 

TONERLOW CONTINU (Factory Default)

STOP

This setting determines whether the printer can continue

printing after the printer detects that the toner is low.

If the toner is low and TONERLOW is set to ‘Stop’, 

press the Continue button to print. In that case, replace the

toner cartridge or set the TONERLOW menu item to 

CONTINU.

OFF (Factory Default)

ON

When JAM RECV is set to OFF, the printer does not 

reprint a page that has been jammed.

When JAM RECV is set to ON, the printer keeps a 

printed page until the printer signals that the page has 

successfully exited the printer. The printer reprints the

jammed page.

Item Values and Functions
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CONFIG MENU

SWITCH
(If the optional 

tray 2 is installed)

LOCKTRAY
(If the optional 

tray 2 is installed

and the SWITCH

menu item is set to

ON)

ON (Factory Default)

OFF

The ON setting makes the printer supply the paper from 

another Tray when a tray is empty.

In case of the OFF setting, an error message is 

displayed.

NONE (Factory Default)

1ST

OPT

MP

The tray set to LOCKTRAY doesn’t change.

For example, if LOCKTRAY is set to MP, the tray is not

switched to Multi-Purpose tray.

ItemItem Values and Functions
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Use the JOB MENU to define all settings relating to print quality, 

as well as Menu clear.

SRT MODE
(Samsung
Resolution
Enhancement 
Technology)

TIMEOUT

ENHANCE (Factory Default)

NORMAL

GRAY

Use the printer’s SRT(Samsung Resolution enhancement 

Technology) setting to produce print with smooth angles,

curves, and edges.  

ENHANCE : Better Text Image

GRAY : Better Photo Image

DENSITY LIGHT

MEDIUM (Factory Default)

DARK

Lighten or darken the print on the page by changing the 

DENSITY setting. 

The MEDIUM setting usually produces the best results. 

0~300

15(Factory Default)

The TIMEOUT Setting determines the amount of time

(in seconds) the printer waits before printing the last page

of a print job that does not end with a command to print

the page. When a print timeout occurs, the printer prints

the data in the print buffer. 

0 : No timeout.

JOB MENU

Item Values and Functions
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PAP.TYPE

MENU CLR

NORMAL (Factory Default)

THICK

WET

TRANSP.

The PAP.TYPE setting lets you specify the type of print 

material installed in each tray.

Select NORMAL if the printer material is plain paper. 

Select THICK if the printer material is thick paper, high

cotton paper or envelopes.

Select WET if printer material is thin paper(60g) 

and the air is humid. 

Select TRANSP. if printer material is transparencies.

This value can only be selected if MP or manual has been

selected from the Tray menu.

SMET
(Samsung Memory
Enhancement 
Technology)

ON (Factory Default)

OFF

This setting makes the printer process more data by 

optimizing the memory. 

If the value is set to ON, the complex data can be

processed.

When you select MENU CLR, the printer resets to the

factory default setting for each menu item. 

JOB MENU

Item Values and Functions
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JOB MENU

DUP.TOP 5.0 (Factory Default)

0~9.9mm (In increments of 0.1)

This item lets you select the top margin of the print 

materials when the Duplex menu item is set to Long.

DUP.LEFT 5.0 (Factory Default)

0~9.9mm (In increments of 0.1)

This item lets you select the left margin of the print 

materials when the Duplex menu item is set to Long.

S-BIND 0 (Factory Default)

0~22mm (In increments of 1)

This item lets you select the left margin for the binding 

when short edge duplexing.

L-BIND 0 (Factory Default)

0~22mm (In increments of 1)

This item lets you select the left margin for the binding 

when long edge duplexing.

FUSER CLEAN Select ‘FUSER CLEAN’ if you notice random dirty spots on

the back side of the paper.

It cleans fuser contamination.

Item Values and Functions
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Use the TEST MENU to print a variety of listings relating to available 
printer resources, printer settings  and print jobs. 

SELFTEST Select SELFTEST to print a configuration page. This menu

item lets you make sure the printer is operating correctly.

For more information, see page 2.11.

DEMOPAGE Select DEMOPAGE to print the standard demonstration

page.

Use the PCL MENU to change printer settings that only affect jobs  
printed using the PCL emulation printer language. 

FONTLIST

SYMBOL

You can print a font sample list showing all 

the fonts available for PCL emulation.

TYPEFACE PCL 1 ~ PCL 54

PCL 1 (Factory Default)

ROMAN 8 
DESKTOP

.

.

PC8  (Factory Default)
List of symbol set name
A SYMBOL set is a set of alphabetic and numeric
characters, punctuation, and specific symbols used when
printing with a selected font.
In PCL emulation, a symbol set also defines which 
character will be printed for each key on the keyboard (or
more specifically, for each code point).

TEST MENU

PCL MENU

Item Values and Functions

Item Values and Functions
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PCL MENU

LINES 5 ~ 128
60 (Factory Default : USA, Canada)
64 (Factory Default : Others Country)

Use the LINES menu item to change the number of lines
that print on each page. 
The setting can range from 5 to 128 lines per page. 
The printer sets the amount of space between each line
based on the Lines, Paper size, and Orientation settings.

PITCH 0.44~ 99.99
10.00 (Factory Default)

If you chose a scalable monospaced font, you can select 
the font pitch. 
PITCH refers to the number of fixed - space characters 
in a horizontal inch of type. 
You can select from 0.44 to 99.99 characters per inch 
in increments of 0.01 cpi. 

PT.SIZE You can select the character size for the font. 
PITCH or PT.SIZE appears according to the value of 
TYPEFACE. 

COURIER REGULAR (Factory Default)

DARK

Item Values and Functions
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This menu is only available if the Serial/LocalTalk option card is installed in
your printer.

BAUDRATE This setting lets you select the rate at which data is being
sent to or from your computer.
Setting the COM Port and printer setting at anything
higher that 19200 bps will create unexpected errors
in DOS mode.
300~115200
9600(Factory Default) 

ROBU.XON ON(Factory Default)

OFF

I/O MENU

FONT LIST Prints the font list showing all the fonts available for

PostScript.

PS.ERROR ON
OFF (Factory Default)

Determines what action the printer should take when an
error occurs in PS interpreter. When set to OFF, the printer
does not print error information when an error occurs in PS
interpreter. When set to ON, the printer prints error infor-
mation when an error occurs in PS interpreter.

PS3 MENU

Item Values and Functions

Item Values and Functions
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This menu is only available if the Network option card is installed in your

printer.

Menu Item Value Enter/Cancel

On Line

Pressing
On Line/Continue

OFFLINE NETWORK
MENU

RESET NIC

CFG NET

LPD

APL TALK

UPDATE

BOOT SVR

FACTORY
DEFAULT

PRINT
NET CFG

TCP/IP

CFG TCP

NETWARE

CFG NWAR

NO

ON

NO

ON

ON

ON

NO

NO

UNIX

The PortThru card is reset

Select YES or NO

Select ON or OFF for enabling

Select YES or NO

Select ON or OFF for LPD printing

Select ON or OFF for enabling

Select ON or OFF for IPX/SPX

Select YES or NO

Select YES or NO or for
upgrading

Select Unix or Windows

Select for Factory Default
settings

Select for test printing

Pressing Menu
cycles forward or

backward

Pressing Item cycles
forward or backward

Pressing Value cycles
forward or backward

Pressing
Enter/Cancel

Pressing
On Line/Continue

On Line

NETWORK MENU
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RESET NIC

CFG NET

The PortThru card is reset.

TCP/IP ON
OFF

This menu item lets you enable TCP/IP.

CFG TCP YES
NO

This menu item lets you configure TCP/IP.

LPD ON
OFF

This menu item lets you print using LPD.

APL TALK

NETWARE ON
OFF

You can configure the printer server for IPX/SPX 
configuration parameters, and FRAME. When you set it to
ON, you may select the Frame Type.

DHCP
CFG ADRS
BOOTP
RARP

YES
NO

You can configure the print server for TCP/IP 
configuration parameters, DHCP, CFG ADRS, BOOTP, and
RARP. When you enable TCP/IP protocol, you have to select
one of the IP Address assignment methods, DHCP, CFG
ADRS, BOOTP, RARP. In case of DHCP, RARP, BOOTP, you
need to configure the server. In case of CFG ADRS, you
have to enter the IP address, Subnet mask, Default
Gateway manually.

YES
NO

This menu item lets you configure network settings.

NETWORK MENU

Item Values and Functions

ON
OFF

When you set APL TALK to OFF, this PortThru can not be
detected by Macintosh systems.
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CFG NWAR

AUTO
EN-8023
EN-II
EN-8022
EN-SNAP

YES
NO

This menu item lets you configure IPX/SPX configuration 
parameters.

UPDATE YES
NO 

You need to set the server that provides the upgrade file. 
You can set it to UNIX or WINDOWS. After setting the server
for update, you should reset the printer. The upgrade process
will be completed.

FACTORY
DEFAULT

You can reconfigure the PortThru card to the factory default
value for each menu item. After selecting this menu, make
sure that you reset printer. 

PRINT NET CFG

Select this menu item to print configuration pages.

BOOT SVR UNIX
WINDOWS 

If you want to upgarde in UNIX System, please select UNIX.
You have to store the file to be upgraded in temporary 
directory of UNIX system and configure MAC address, 
IP address, the file name and the file path in bootptab file. If
you want to upgrade in WINDOWS System, please select 
WINDOWS. You have to enter the IP address of Windows’s PC
that has the upgrade file.

ON
OFF

These items are the frame type for IPX/SPX protocol. 
You can select one of these. If you don’t set any value,
Auto(default value) which switches the frame types 
automatically is used.

NETWORK MENU

Item Values and Functions
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To reset PortThru

1 Press On Line/Continue. OFFLINE appears on the display.

2 Press Menu until NETWORK MENU appears on the display.

3 Press Item until RESET NIC appears on the display.

4 Press Enter and READY appears on the display. 

To configure network settings for PortThru.

1 Press On Line/Continue. OFFLINE appears on the display.

2 Press Menu until NETWORK MENU appears on the display.

3 Press Item until CFG NET appears on the display.

4 Press Value until YES appears on the display.

5 Press Enter and you can configure the following network settings now.

6 Skip this step if you don’t want to configure TCP/IP. Press Item until 

TCP/IP appears on the display.

a  Press Value until ON appears on the display.
b  Press Enter and PortThru can use TCP/IP 

for communicating.
c  Press Item until CFG TCP appears on the display.
d  Press Value until YES appears on the display.
e  Press Enter and you can select the IP address assign

ment method.
f  Press Item until the IP address assignment method 

you want appears on the display.
g  Select the YES by pressing the Value button.
h  Press Enter.
i  Skip this step if you don’t select CFG ADRS as the IP address

assignment method. Enter the IP address, 
Subnet mask, Default gateway by using Item, 
Value and Enter buttons. 

NETWORK MENU

Resetting PortThru

Configuring Network setting for PortThru
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7 Skip this step if you don’t want to use LPD. LPD appears only if 
TCP/IP is ON. Press Item until TCP/IP appears on the display.

a  Press Value until ON appears on the display.
b  Press Enter.
c  Press Item until LPD appears on the display.
d  Select the ON by pressing the Value button.
e  Press Enter and PortThru can print using LPD.

8 Skip this step if you don’t want to use AppleTalk protocol. 
Press Item until APL TALK appears on the display.

a  Take the ON by pressing the Value button.
b  Press Enter and PortThru can communicate with AppleTalk 

protocol.

9 Skip this step if you don’t want to use IPX/SPX protocol.
Press Item until NETWARE appears on the display.

a  Press Value until ON appears on the display.
b  Press Enter.
c  Skip this step if you do not want to configure IPX/SPX. Press

Item until CFG NWAR appears on the display. Select the YES
by pressing the Value button, then Press Enter.

d  Press Item until the frame type you want to use appears on
the display.

e  Select the ON by pressing the Value button.
f Press Enter. 

NETWORK MENU
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To upgrade the firmware of your PortThru. This section is
explaination of upgrading the Firmware in abnormal case.
Generally, please use SyncThru for upgrading Firmware.

1 Press On Line/Continue. OFFLINE appears on the 
display.

2 Press Menu until NETWORK MENU appears on the 
display.

3 Press Item until UPDATE appears on the display.

4 Select YES by pressing the Value button.

5 Press Enter.

6 If Unix is the server that provides the upgrade file, go to
step 7. Otherwise go to step 8. 

7 In case of Unix server:

a  Press Item until BOOT SVR appears on the display.
b  Press Value until UNIX appears on the display.
c  Go to step 9.

8 In case of Windows server: This step should be taken after
executing the section Upgrading Firmware In Abnormal
Cases (see page 3.26).

a  Press Item until BOOT SVR appears on the display.
b  Press Value until WINDOWS appears on the display. 
c  Enter the IP address of the server to provide upgrade

file by using Item, Value and Enter button.

9 Please refer Upgrading the Firmware in UNIX Environment
or Upgrading the Firmware in Windows Environment. And
then Reset print and the firmware will be upgraded.

Upgrading Firmware In Front Panel

NETWORK MENU
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Restoring Factory Defaults

To restore factory default settings to the printer.

1 Press On Line/Continue. OFFLINE appears on the display.

2 Press Menu until NETWORK MENU appears on the display.

3 Press Item until FACTORY DEFAULT appears on the display.

4 Press Enter.

5 Reset printer and all settings will be reset to factory defaults.

Printing Test Pages

You can use the Front Panel to print out important information
pages describing PortThru settings.

1 Press On Line/Continue. OFFLINE appears on the display.

2 Press Menu until NETWORK MENU appears on the display.

3 Press Item until PRINT NET CFG appears on the display.

4 Press Enter and the test pages will be printed out. 
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NETWORK MENU

Setting Unix as BOOTP server

1 There must be a BOOTP server present in the network 
environment in which the network printer is present.

2 On the BOOTP server the /etc/bootptab file must be created and an 
entry for the boot parameters must be made in the file as follows:
(Please check with your system manual).

npc:\
:pc:\
:ht=ether:\
:ha=0000F0A12345:\
:sm=255.255.255.0:\
:gw=200.160.251.1:\
:lg=200.160.251.51:\
:sa=200.160.251.52:\
:hn:
:ip=200.460.251.18:\
:bf=”/test/Firmwareup”.\
:vm=rfc1048:
:ht=hardware type, ha=hardware add, image:download file name

Upgrading the Firmware

1 Set UPDATE to YES in the Network menu on the printer front panel.

2 Set BOOT SVR to UNIX.

3 Reset the printer.

4 It may take 3 minutes to reboot the printer. 
Rebooting time depends on network traffic.

Upgrading the Firmware in a Unix Environment

Notes: • Firmware upgrading requires Tftp protocol. 

Check whether Tftp daemon is installed in advance.

• Setting IP Address Assignment Method to DHCP is 

recommended in order to execute Firmware upgrading.
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NETWORK MENU

Any error in the process of upgrading may result in disabling
PortThru. In this case, perform the following steps.

In SyncThru

1 Select the Upgrade Firmware menu item under the
Maintenance menu in SyncThru.

2 You can see the Choose the Upgrade Firmware File dialog box. 

3 Check “Wait Printer Request” and “Set as Default Download”.

4 Select the Firmware file Name you downloaded and its path, 
and then click Start.

5 You will see the message ”Please set the values through the
FRONT Panel to initiate FLASH Upgrade”. Click OK.

After this procedure, move to printer which you want to
update and do as following procedure.

In Front Panel of the printer

6 Press On Line. OFFLINE appears on the display.

7 Press Menu until NETWORK MENU appears on the display.

8 Press Item until UPDATE appears on the display.

9 Select YES by pressing the Value button.

10 Press Enter/Cancel.

11 Press Item until BOOT SVR appears on the display.

12 Press Value until WINDOWS appears on the display.

13 Press Enter/Cancel.

Upgrading the Firmware in Abnormal Cases



14 Set the IP address of the WINDOWS pc running SyncThru
in step1. For example, if the IP address is 155.213.211.12,
follow these steps:

a  Press Item until SV-IP B1 appears on the display.

b  Press Value until 155 appears on the display.

c  Press Enter/Cancel.

d  Press Item until SV-IP B2 appears on the display.

e  Press Value until 213 appears on the display.

f  Press Enter/Cancel.

g  Press Item until SV-IP B3 appears on the display.

h  Press Value until 211 appears on the display.

i  Press Enter/Cancel.

j  Press Item until SV-IP B4 appears on the display.

k  Press Value until 12 appears on the display.

l  Press Enter/Cancel.

15 Reset printer and the firmware will be upgraded.

NETWORK MENU

Notes: After the ”Completed. Network Card will start about 30secs

later” message is displayed on SyncThru, click OK. 

It may take a few seconds to write the new file to Firmware.

Normally 30 seconds is sufficient.

USING OPERATOR PANEL 3.27



Print MediaPrint Media
This chapter will help you understand what kind of paper
you can use with the ML-7300 series printer and how to
properly load paper in the different paper trays for the best
print quality.

Topics included in this chapter are:

◆ Loading Paper

- Using the Multi-Purpose Tray

- Using the Manual Feed.

- Letterhead/Prepunched Paper

- Envelopes

- Label

- Transparencies

44



PRINT MEDIA 4.1

Loading Paper

Multi-Purpose tray provides a convenient way to print envelopes, transparencies, 
or other type of media without having to unload the other tray.

To load paper in the Multi-Purpose tray, proceed as follows.

Using the Multi-Purpose Tray

1 Pull the Multi-Purpose tray
towards you.

2 Slide the length guide out toward
you.
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Notes: • Do not fold or crease the paper.

• Place the paper with the recommended print side face up.

3 Flex the sheets back and forth
to loosen them, then fan them.

4 Place the paper against the side
of the Multi-Purpose tray with
the recommended print side face
up and the top edge going in
first toward the printer as
shown.

5 Adjust the paper guide to the
size of the paper inserted by
pushing the guide. 

Loading Paper
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1 Select Manual as the paper source.
• Set the source item in the properties dialogue box to Manual.
• You can select Manual as the paper source by setting the Tray item

using the operator panel menu.

2 Print your document.

3 Place a sheet of paper in the 
Multi-Purpose tray.

4 Press continue key when you are
prompted.

The Manual Feed feature allows you to print from the Multi-Purpose tray onto 
special media such as envelopes or letterhead.
If the Tray menu item is set to Manual, the printer will print only from the 
Multi-Purpose tray. 
Manual Feed can be selected through the software or printer driver too. 

Loading Paper

Using the Manual Feed
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For Multi-Purpose tray, 

Load the paper with the side-to-be-
printed facing up, and the top, short
edge toward the printer.

• Set the source item in the 
properties dialogue box to 
Manual or MP.

- To print continuously from 
Multi-Purpose tray, 
set the source item to MP.

- To print a sheet of paper from 
Multi-Purpose tray, 
set the source item to Manual.

For ALL other trays, 

Load paper with the side-to-be-
printed facing down, and the top,
short edge toward you.

Loading Paper

Letterhead / Prepunched Paper

Printing Side(down)

Printing Side(up)

Special paper includes letterhead, prepunched, envelopes, labels, 
and transparencies.

When printing letterhead and prepunched paper, it is important to load the trays 
with the correct orientation.
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Many types of envelopes can be printed from the Multi-Purpose tray. 
The types of envelopes are COM-10, MONARCH, DL, C5 and C6(60~90g/m2).
The printer will automatically feed up to 10 envelopes.
Printing performance depends on the construction of the envelope.

Pr int ing  in format ion

• Set margins at least 0.6inch(15mm) from the edge of the envelope.
• Always test a few sample envelopes before purchasing large quantities.
• Select THICK paper for better quality.

Envelopes guidelines

For best performance, use envelopes made from 75g/m2(20lb bond) paper.

Do not use envelopes that : 
• Are damaged in any way. 
• Use metal claps, string ties, metal folding bars.
• Contain windows, holes, cutouts or embossing.
• Have exposed flap adhesive when the flap is in the sealed or closed 

position. For envelope specifications, see page Appendix A.4. 

1 Open the Multi-Purpose tray. 
Pull out the extension.

Envelopes

Load ing  enve lopes

Loading Paper
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(Side View)

2 Load up to 10 envelopes in the
left side of Multi-Purpose tray
with the side-to-be printed 
facing up, and the postage-end
toward the printer.

Samsung �

3 Adjust the guide to touch the
envelope stack without bending
the envelopes.

4 Set the source item in the properties dialogue box to Manual or MP.

Notes: Do not use an envelope curled 

down side, refer to the figure.

Loading Paper
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Labels automatically feed from the Multi-Purpose tray or the other trays.

Label guidelines

Make sure that labels meet the specifications for the tray you use.

• Use full label sheet. Partial sheets may cause labels to peel off during
printing, resulting in a paper jam.

• The adhesive material should be stable at 400OF(205OC), the printers
maximum temperature.

• Do not use labels that have the backing sheet exposed.

• For Multi-Purpose tray, load the
labels with the side-to-be-printed
facing up, and the short edge
toward the printer. Print a stack of
25 labels from Multi-Purpose tray.

Notes: Do not print on both sides of labels.

Loading Paper

Label

Labe l  or ientat ion
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•  For Multi-Purpose tray, load the 
transparencies with side-to-be-print-
ed facing up, and the top toward the
printer. 
Print a stack of 25 transparencies
from the Multi-Purpose tray.

Transparencies automatically feed from the Multi-Purpose tray or the other trays. 
Some brand of transparencies may require manual feeding.
The Multi-Purpose tray is a tray that holds up to 25 sheets of A4 or Letter size paper.

Transparencies guidelines

• Use only transparencies recommended for use in laser printers.
• Place transparencies on a flat surface to cool after removing them from the

printer.

Transparencies orientation

Transparenc ies

Notes: •  Because transparencies are heavier than paper, 

do not load the trays to capacity.

•  Remove each transparency from the output bin before 
printing another.

Loading Paper
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MemoMemoMemoMemo
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This chapter explains your printing options and gives common

printing tasks.

Topics included in this chapter are:

◆ Using Features in the Printer Driver

- With Windows 95/98/NT 4.0/2000

◆ Using the Printer Driver

- Paper Tab

- Graphic Tab

- Output Tab

- Printer Tab

- Overlay Tab

- Watermark Tab

◆ Printing Both Sides of Paper 

◆ Printing Multiple Pages on One Sheet of Paper (N-Up Printing)

◆ Printing Booklets

◆ Printing on Different Paper for the First Page

◆ Fitting Your Document To a Selected Paper Size

◆ Printing Posters
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Using Features in the Printer Driver

When you print from a software application, many of the printer’s
features are available from the printer driver.

To change the settings from a software application, follow this procedure.

1 Select Start-Settings-Printers from the Windows task bar.

2 Double-Click on the desired printer driver icon.

3 Select Printer-Properties.

4 Click on the appropriate tab.

5 Select the required options.

With Windows 95/98/NT 4.0/2000

General
You can print a 
test page and 
view the driver 
information.

See page 5.8

Sharing
You can share the

printer.

See page 5.9

Details
You can select the

printer port and spool

setting.

See page 5.6

See page 5.4

See page 5.11

See page 5.2

Notes: Changes made from a software application override the user default setting
made from the printer operator panel.
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The features of the printer driver are organized under ten tabs : 
Click on a tab at the top of the properties window to access one of the nine
dialog boxes.

Each tab of the properties box is described in this section.

You can restore all the original settings of the PCL 6 printer
driver by clicking Defaults.

Using the Printer Driver

Paper Tab
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Copies
Use the Copies box to set the number of copies you
want to print.

Paper Orientation
Choose Portrait or Landscape to select the default
orientation of the printed page.

Different Soruce for First Page
If the box is checked, this feature is enabled and the
dialog box allows you to select the desired paper
source for the First Page and Other Pages
independently. 
If the box is empty, this feature is disabled. 

Paper Source
The source setting identifies the default paper tray.

Paper sizes
Use this setting to select the paper size.

Paper type
The Paper type setting lets you specify the type of
print material installed in each tray.

����
Landscape

����
Portrait

printable 
area

Important If you want to know more about each menu, click on the Help button.
The help screen gives detailed information about each menu.

Using the Printer Driver

Notes: The paper size for all pages of the print job 
must be the same.



Using the Printer Driver

PRINTING TASKS5.4

The settings on the Graphic tab allow you to fine tune your image quality
and to balance print quality and print speed.

Graphic Tab

You can restore all the original settings of the PCL 6 printer
driver by clicking Defaults.
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Using the Printer Driver

Resolution
Select from the available setting to set the maximum
resolution for your print jobs.

SRT Mode
Some printed characters or images can appear to have
jagged or uneven edges. Set this Samsung Resolution
enhancement Technology (SRT) option to improve the
print quality of your text and image and to make the
characters and images appear smoother. 

Toner Save Mode
This determines the amount of toner to be used while
printing a page. The printer uses 50% less toner when
Toner Save Mode is selected.

Graphic Mode
This setting allows you to change the Graphic Mode.

Halftoning
This setting lets you fine-tune the way colors in graphic
images are converted to gray dot patterns.

Important If you want to know more about each menu, click on the Help button.
The help screen gives detailed information about each menu.

Notes: SRT Mode is disabled when 1200 dpi settings are
selected.



Output Tab

PRINTING TASKS5.6

You can restore all the original settings of the PCL 6 printer
driver by clicking Defaults.

Using the Printer Driver
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Using the Printer Driver

Pages per Sheet(Multiple Images)
Use the Pages per Sheet setting to print
multiple pages on a single sheet of paper.

• You can fit 1, 2, 4, 6, 9 or 16 pages 
on a single sheet of paper. 
For example, 2 means two page images are
printed on one page. 

• The print page borders setting determines
whether a border is printed around each
page image.

Duplex
Use the Duplex box when you want to print on
both sides of the paper. See page 5.13.

Important  If you want to know more about each menu, click on the Help button.
The help screen gives detailed information about each menu.
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Printer Tab

Printer Memory
Select the value of  the printer
memory installed in the printer.

After adding more memory, set
the value of the printer memory.

Important If you want to know more about each menu, click on the Help button.
The help screen gives detailed information about each menu.

Using the Printer Driver
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Using the Printer Driver

Overlay Tab
An overlay is text and/or images stored in the computer HDD as a special file
format that can be printed on any document you choose. 

Overlays are often used to take the place of preprinted forms 
and letterhead paper.
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Overlay List

The file is now shown in the Overlay List
box and is available for printing. 
Select the overlay from the Overlay List
box.

Create Overlay
To use a page overlay, you must create a
new page overlay containing your logo or
image.

Load Overlay
If you have stored the overlay file you
want to use into an external source, you
can also load the file when you access this
Load Overlay window.

Important If you want to know more about each menu, click on the Help button.
The help screen gives detailed information about each menu.

Using the Printer Driver
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Using the Printer Driver

A Watermark is text that is superimposed on your final output. 
Usually in a lighter gray you can create a watermark with your own text.

Watermark Tab
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Message
You can select a watermark from the
message list.

Edit
Use this dialog box to enter the text
and layout of your watermark. 
You can set the watermark’s font, size
and darkness, as well as the angle and
position on the page.

The preview area shows the effect of
your settings.

Important: If you want to know more about each menu, click on the Help button.
The help screen gives detailed information about each menu.

Using the Printer Driver
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The printer can automatically print on both sides of paper by setting the 
Printing Menu or Output tab of the Samsung ML-7300 PCL 6 Driver.

1 Open the document to be printed in the appropriate application.

2 Click on the Print button.

3 Click on Properties.

4 Click on the Output tab.

5 Set the Duplex item to Short Edge or Long Edge, 
and select the source item.

Place the paper against the left side of the Tray (See page 5.15).

Long Edge

Short Edge

Printing Both Sides of Paper

Notes: • Do not print on both sides of labels, transparencies, envelopes, or paper  
heavier than 24lb. Damage to printer and paper jamming might result.

• For duplex printing, it is recommended to print less than 1,500 pages a day 
to keep a good image quiality.

Result: The Output tab is displayed.
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1 Make sure the READY message appears on the display.

2 Press On Line.

3 Press Menu until you see PRINTING MENU. 

4 Press Item until you see DUPLEX.

5 Press Value until the setting you need appears on the display
(For more information, see page 3.8).

6 Press Enter to save the selection.

If you use a driver which does not have a properties box.
you can select ‘DUPLEX’ by using the control panel menu.

Notes: Settings in the printer driver and software
application override operator panel settings.

Menu Setting

Result: An asterisk(❊ ) appears beside the current user default
setting for that menu item.

Result: The ‘OFFLINE’ message appears on the display and the printer is off-line.

Printing Both Sides of Paper
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The printer prints the second sides of paper first, so paper such as letterhead 
and preprinted paper needs to be oriented as illustrated in the figure below.

Paper Orientation for Printing both sides of Paper

For Multi-Purpose tray
Load the first side facing down and 
the top toward you. 

• Set the source item in the
properties dialogue box to 
Manual or MP.

- To print continuously from 
Multi-Purpose tray, set the source
item to MP.

- To print a sheet of paper from 
Multi-Purpose tray, 
set the source item to Manual.

For all other Trays
Load the first side facing up and 
the top toward the printer. 

Multi-Purpose Tray

Printing Both Sides of Paper

Tray
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1 2

3 4

You can select the number of pages you want to print on a
single sheet of paper. If you choose to print more than one
page per sheet, the pages will appear decreased in size and
arranged on the sheet. You can specify up to 16 pages.

1 When you change the print settings from your software
application, access the printer properties. See page 5.1 to
access the printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, and choose Multiple Pages per
Side in the Type drop-down list. Then select the number of
pages you want to print per sheet (1, 2, 4, 6, 9 or 16) in
the Pages per Sheet drop-down list.

3 Click Print Page Borders if you want to print a border
around each page on the sheet. Print Page Borders is
enabled only if Pages per Sheet is 2, 4, 6, 9, or 16.

����4 pages per sheet

1
2

4

36
5

����6 pages per sheet

Printing Multiple Pages on 
One Sheet of Paper (N-Up Printing)

4 Click OK, then start printing. 
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����
Portrait orientation

Printing Booklets

8 9

����
Landscape orientation

7
1

9

Booklet printing feature allows you to print your document as
a 2-sided (duplex) job and arrange the pages so that the
paper can be folded in half after printing to produce a booklet. 

1 When you change the print settings from your software
application, access the printer properties. See page 5.1 to
access the printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, then choose Booklet Printing from
the Type drop-down list. 

When you select Booklet Printing, the Duplex option
automatically changes to Short Edge. This setting is
required to format the printed pages correctly.

Notes: For booklet printing, only four paper sizes are
supported: Letter, A4, Legal, and Executive.

3 Print the document. 

4 Fold and staple the pages.

��������8-page document

8 1
6 3

8 9
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Printing on Different Paper for the First Page

1 When you change the print settings from your software
application, access the printer properties. See page 5.1 to
access the printer properties.

2 Click the Paper tab, and click Different Source for First
Page. 

If the box is checked, this feature is enabled and the dialog
box allows you to select the desired paper source for the
First Page and Other Pages independently. If the box is
empty, this feature is disabled. 

3 Click OK, then start printing. 

Notes: The paper size for all pages of the print job must
be the same.
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Fitting Your Document To a Selected Paper Size 

This printer feature allows you to scale your print job to any
selected paper size regardless of the digital document size.
This can be useful when you want to check fine details on a
small document. 

1 When you change the print settings from your software
application, access the printer properties. See page 5.1 to
access the printer properties.

2 Click the Output tab, and select Fit to Page in the Type
drop-down list. 

3 You’ll see the Application page size and be prompted to
select the Fit to Paper Size. Select the correct size from
the drop-down list.

4 Click OK, then start printing.

A



PRINTING TASKS5.20

Printing Posters

This feature allows you to print a single-page document onto
4, 9, or 16 sheets of paper, which can be pasted together to
form one poster-size document.

1 When you change the print settings from your software
application, access the printer properties. See page 5.1 to
access the printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, and select Poster in the Type
drop-down list.

����
Poster printing
with 2x2 style



Printing Poster

➛➛����➛➛����2 x 2

������������Overlap=0 ������������Overlap=25

25 pixels

25 pixels

➛➛����➛➛����Custom (150%)

5 Click OK, then start printing. 

3 To determine the scaling factor, select the Style; 2x2, 3x3,
4x4 or Custom.

For example, if you select 2x2, the output will be
automatically stretched to cover 4 physical pages.

If you select Custom, you can adjust the scaling factor
manually. For example, if you specify 150%, the image will
be printed across 4 pages with 150% scaled.

4 You may specify an overlap in pixel to make it easier to
reconstruct the resulting poster.

PRINTING TASKS 5.21



Maintaining 
Your Printer
Maintaining 
Your Printer
This chapter provides suggestions for high-quality
and economical printing and information for
maintaining the toner cartridge and the printer. 

Topics included in this chapter are:

◆ Toner Cartridge

◆ Cleaning the Printer

◆ Cleaning LSU
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Toner Cartridge

Do not remove the toner cartridge from its package
until you are ready to use it.

Toner cartridge storage

The life of the toner cartridge depends on the amount
of toner that print jobs require.
When printing text at 5% coverage, a Samsung toner
cartridge lasts an average of 10,000 pages in simplex
mode, depending on which toner cartridge is installed. 
This assumes that print DENSITY and ECONO menu
items are set to default.

Toner cartridge life 

Notes: To prevent damage to toner cartridge, 
do not expose it to light.

When toner is low, faded or light area might appear
on a printed page. 
You might be able to temporarily improve print quality
by distributing the toner.

Distributing the Toner
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Toner Cartridge

When toner is low, faded or light areas may appear on a printed page. 
You may be able to temporarily improve print quality by redistributing the
toner. The following procedures may allow you to finish the current print job
before replacing the toner cartridge.

Redistributing Toner

1 Open the top cover by pushing
the button on the side of the
printer.

2 Remove the toner cartridge
from the printer.

CAUTIONS:

• Avoid reaching too far into
the printer. The fusing area
may be hot.

• To prevent damage to the
toner cartridge, do not
expose it to light for more
than a few minutes.
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Toner Cartridge

3 Gently shake the toner cartridge
from side to side 5 or 6 times to
redistribute the toner.

4 Reinsert the toner cartridge into
the printer. Be sure that the
toner cartridge is firmly in its
place.

5 Firmly close the cover.

If the print remains light 

Remove the old cartridge and
install a new toner cartridge. 
See “Installing Toner Cartridge” 
on page 2.3.

Notes: If the toner gets on your

clothing, wipe it off with a dry cloth

and wash clothing in cold water.

Hot water sets toner into

fabric.



MAINTAINING YOUR PRINTER6.4

Cleaning the Printer
To maintain print quality, you should clean the printer.
•  Never use alcohol or solvent based cleaning agents to clean the printer

as they may damage the printer casing and components.
•  Never use a hard-bristled brush or abrasive pad. 

To clean your printer, proceed as follows.

2 Remove the paper from 
Multi-Purpose tray.

3 Open the top cover and remove
the toner cartridge.

1 Check that the printer is powered off and disconnected from the
power point.
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Cleaning the Printer

4 Use a soft cloth to remove any
dust.

5 If the outer casing or the paper feed guides are dirty, clean them with
a soft, clean cloth, slightly dampened with a gentle detergent.

6 Clean the inside of the printer with a damp cloth.

7 Replace the toner cartridge, close the top cover, plug in the power
cord, and turn the printer on. 

Notes: While cleaning the printer, be careful not to touch the transfer 
roller(the black, rubber roller, located underneath the toner cartridge). 
Skin oils on the roller can cause print quality problems.
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Cleaning LSU

3 Slide the LSU cleaner
horizontally across a track on
the top of the LSU.

To obtain high quality from your printer, clean the LSU(Laser Scanning Unit)
when characters have lines running through them.

1 Open the top cover and remove the toner cartridge.

2 Pull up on the LSU cleaner and put it on the LSU.

Notes: For more information on using method, see

attached label on the inside of the top cover.



MAINTAINING YOUR PRINTER 6.7

MemoMemoMemoMemo
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This chapter gives helpful information for
what to do if you encounter a printer error. It
provides information on the following topics:

◆ Clearing Paper Jams

◆ Error Messages

◆ General Printing Problems

◆ Poor Print Quality

◆ PS(PostScript) Problems

◆ Network Problems

◆ Macintosh Problems
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PROBLEM SOLVING 7.1

If the printer’s operator panel displays a paper jam message, look for paper in
the locations indicated in the figure below, then perform the procedure for
clearing the paper jam.

Clearing Paper Jams

Notes: Be very careful not to tear the paper, when clearing paper jams.  
If a small piece of paper is left in the printer, it could cause additional jams.

Paper Jam Locations



PROBLEM SOLVING7.2

Problem

‘PAPER JAM0’ 
message appears 
on the LCD

Solution

1 Slide the tray out
of the printer, and
remove any dam-
aged paper from
the tray.

Notes : If the edge of the paper is visible in the
feed area, slowly pull the paper down
and out of the printer.

2 Make sure the
paper is below
the tab on the
guide.

4 Open and close the top cover to clear the
paper jam message.

3 Replace the tray.

Clearing Paper Jams
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Notes: The paper jam locations for both sides printing are different
from those of normal printing. Refer to page 7.1.

‘PAPER JAM1’ or
‘PAPER JAM2’ 
messages appear 
on the LCD

Check 1
• Open and close the top cover. 

The paper comes out of the printer.

Check 2 (JAM 1)
• Open the top cover and 

remove  the toner 
cartridge.

• Slowly pull the paper 
out of the printer.
Do not tear the paper.

• Replace the toner 
cartridge, and close the
top cover.

Check 3 (JAM 2)
• Open the rear cover.
• Grasp both sides of the

paper, and slowly pull
the paper out of the
printer.

Check 4
• Open and close the top cover to clear the paper

jam message.

Clearing Paper Jams

Problem Solution
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‘DUPLEX JAM 1’ or
‘DUPLEX JAM 2’ 
messages appear 
on the LCD

Check 1 
(DUPLEX JAM 1)

•  Open the rear cover.
•  Grasp both sides of

the paper, and slowly
pull the paper out of
the printer.

Check 2 (DUPLEX JAM 2)

•  Pull the tray completely out
of the printer.

• Pull down the metal plate
inside of the printer.

•  Slowly pull the paper 
out of the  printer.

Clearing Paper Jams

Problem Solution
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The following table explains messages that might display on the printer

operator panel.

Error Messages

Message Meaning and Requried Action

A cover is open.

• Close the cover.

The printer is running out of toner. 
Purchase a new cartridge and replace the toner
cartridge.

The toner is low. The TonerLow menu item is set to STOP.

•  Purchase a new cartridge and replace the toner car-

tridge.

•  Set the Toner Low menu item to CONTINU.

•  Press the Continue button.

The printer detects a paper jam. Open the cover and

remove the jammed paper, refer to page 7.2

for more information.

The printer detects a paper jam while printing both

sides of paper.

•  Open the cover and remove the jammed paper.

Load the paper to clear the message.

The Toner cartridge is not installed properly, or is not
SAMSUNG-approved cartridge. Open the top cover and
install the cartridge properly. If the proplem persists,
please contact your service representative.



PROBLEM SOLVING7.6

The requested paper size does not correspond

with the loaded paper size in the displayed tray.

Press Continue key.

Load the paper into the Multi-Purpose tray.

An internal error has occurred.

•  Turn the printer off, and then turn the printer on.

•  Contact your local dealer or after-sales service.

Data which was too complex was sent to the

printer.

•  If this message persists, expand the memory.

The program in the memory has been damaged

in someway.

•  Contact your local dealer.

Error Messages

Message Meaning and Requried Action



PROBLEM SOLVING 7.7

The printer detects a serial interface error.

● Set the same Baudrate.

There is not enough memory in the printer.

● You might want to add more memory to the

printer.
● Check that the SMET menu item is set to ON.

The 1ST TRAY is open.

Close the 1ST TRAY to clear the message.

The OPT TRAY is open.

Close the OPT TRAY to clear the message.

The 1ST TRAY is open, but you can print 

through MP TRAY.

Close the 1ST TRAY to clear the message.

The OPT TRAY is open, but you can print through

1ST tray or MP tray.

Close the OPT TRAY to clear the message.

Error Messages

Message Meaning and Requried Action



PROBLEM SOLVING7.8

General Printing Problems

• Check the power cord connections. 

• Check that the power supplied to the printer is

steady and meets printer specifications.

• Turn the printer off, and then turn the 

printer on.

1 Select START ➔ Settings ➔ Printers from
Windows task bar (See page 5.1).

2 Click on the PCL 6 or PS printer icon.

3  Select File ➔ Default Printer. 

• Check the printer cable connections 
(See page 2.8).

• Check the printer port on your computer.

• Check that all trays are properly loaded,

adjusted, and installed in the printer.

• Check that all covers are correctly closed.

The power does not

turn on.

The printer does not
operate by pressing
the button on the
operator panel.

It cannot print from

software applications.

The printed data is
not sent to the
printer.

The test page is 

not printed.

Problem Solution



PROBLEM SOLVING 7.9

Poor Print Quality

• Distribute the toner in toner cartridge (See page 6.1).

• Adjust the ‘Density’ menu item setting (See page 3.12).

• Clean the inside of the printer (See page 6.4). 

• Print a few more pages to see if the problem 
will correct itself.

• Clean the inside of the printer (See page 6.4). 

• Check the paper type and quality.

• Check the paper type and quality.

• Check the printers environment.

• Install a new toner cartridge.

• Check the printer cable connections.

The vertical lines are
printed on the page. 
Print is too light.

There are toner 

speckles.

The printer 

drops letters.

• Heavy printing may lead to toner accumulationg
on the pressure foller of the fuser assembly. The
accumulated toner may melt and transfer onto
the back side of the paper.

• Select ‘FUSER CLEAN’ in the JOB MENU.

• Selecting ‘FUSER CLEAN’ will rotate the motor

for about 10 seconds and print one page of a

specified pattern for fuser cleaning and then stop.

Dirty spots on the

back side of paper

of fuser ass’y

contamination.

Problem Solution



PROBLEM SOLVING7.10

PS(PostScript) Problems

1 Open the Properties of PS driver.

2 Click on PostScript.

3 Click on the Advanced button.

4 The pure binary data is not supported.

Choose the others.

The Error messages

(This job contains

binary data...) are

printed.

1 Open the PS driver Properties.
2 Set ‘Optional Tray 2’ item of Device Option to

installed.

The Optional Tray2 is

not selected in PS

driver.

Network Problems

There are two methods.

• On the printer front panel, you can set IP

address in Network Menu. You can find the

following menu.

”NETWORK MENU ➜ CFG NET ➜ TCP/IP ➜

CFG TCP ➜ CFG ADRS”

You cannot see any of

DHCP server, BOOTP

server or RARP server,

when you want to set IP

address to print server.

Problem Solution

Problem Solution



Macintosh Problems

The printer driver
icon does not appear
in the Chooser 
dialogue box.

Your printer name
does not appear in
the Chooser dialogue
box.

• Reinstall the printer software. 
See ‘Installing Software’ on page Appendix B.1.

The printer driver
does not automatically
setup the printer
when you click Auto
Setup in the Printer
Setup window.

• LaserWriter 8.x driver should be installed in Mac
OS. Check that it is in the Extensions 
folder under the System folder. If not, install
LaserWriter 8.x driver.

• Make sure that you use the standard cable.
• Make sure that the printer is connected to the

proper network. 
Check AppleTalk in the Control 
Panel on the Apple menu.

• Make sure that the printer is turned on and
‘READY’ appears in the display.

• Check that the LocalTalk cable is 
completely plugged into both the printer and your
Macintosh computer.

• Make sure that AppleTalk in Chooser is active.

Problem Solution

PROBLEM SOLVING 7.11



Appendix

SpecificationsSpecifications

This appendix provides information on the following

topics:

◆ Printer Specifications

◆ Paper Specifications

AA



CPU

Emulations

Memory

Interface

Font

N/W Card

Device Driver

SPECIFICATIONS A.1

Printer Specifications

Power PC, 100MHZ

• Default: PCL 6, PS 3

• 16MB Standard

• Max up to 208MB

• IEEE 1284 B type

• Option:

Serial RS-232C/LocalTalk

Serial RS-232C/IrDA

Infrared Adapter Connector

Network

45 Scalable font, 1 Bitmap

• Ethernet 10/100 base Tx

- SNMP in MIB

- TCP/IP

- Netware, Windows, Unix, Mac

PCL: Windows 95/98/NT 4.0/2000

Controller

*PostScript 3 Emulation
IPS-PRINT_Printer language Emulation© Copyright
1995-2000, Oak Technology, Inc., All rights reserved

Characteristic Description



SPECIFICATIONSA.2

Printer Specifications

21 PPM (Letter size)

1200 DPI + SRT

Eletrophotography

Non-mag monocomponent/contact

Less than 70 secs

Less than 12 secs

427 ✕ 449 ✕ 301(W ✕ D ✕ H)mm

Less than 16.5kg

AC 100 ~ 127 V (USA, Canada)

AC 220 ~ 240 V (Others), 50/60 Hz

350W Printing Avg/ Max 34W printing sleep

Printing:    52dB
Standby:   36dB
Sleep: Background noise

10,000 pages Avg at 5% coverage

In duplex mode, less than 10,000 pages

Speed

Resolution

Imaging

Toning/Fusing

WarmUp time

FPOT

Size(WDH)

Weight

Power Rating

Power Consumption

Noise Level

Toner Cartridge

IEEE 1284

RS-232C
LocalTalk(RS-422)

RS-232C
IrDA

Parallel

Serial

IrDA

Characteristic Description

Enginge

Cable

Characteristic Description



SPECIFICATIONS A.3

Printer Specifications

500 sheets - Tray 1

500 sheets(40 envelopes) - Optional Tray 2

250 sheets Facedown

100 sheets(10 envelopes)

• Tray 1 : A4, LTR, Folio, Legal, Exec, 
ISO B5, JIS B5 (16~24lbs)

• Multi-Purpose Tray : 
A4, LTR, Folio, Legal, Exec, 
Statement, ISO B5, JIS B5, A5, 
A6, OHP, Label, COM-10, MON,
DL, C5, C6

• Tray 2 : A4, LTR, Folio, Legal : (16 - 24 lbs)
COM-10, MON, DL, C5 : (20 lbs)

• Paper : A4, LTR, Folio, Legal : (20 - 24 lbs)

Input Capacity

Optional Input

Output Capacity

MP Tray

Type of Media

Duplexing

Operating: 10 OC ~ 30 OC

Storage: 0 OC ~ 35 OC

Operating: 30% ~ 80%

Storage: 10% ~ 90%

Temperature

Humidity

● 8 ✕ 2 LCD

● LCD Display angle adjusting

● Backlighting

Control Panel

Package Weight ●     Paper: 3 kg   

● Plastic: 0,7 kg

Paper Handling

Environment

Others

Characteristic Description

Characteristic Description

Characteristic Description



SPECIFICATIONSA.4

Paper Specifications

The following table gives details about the print material you can load 
into each of the printer trays.

A4

LETTER

FOLIO(LEGAL 13”)

LEGAL(LEGAL 14”)

EXECUTIVE

STATEMENT

ISO B5

JIS B5

A5

A6

ENVELOPE
- COM-10
- MONARCH
- DL
- C5
- C6

TRANSPARENCY 
- A4
- LETTER

LABEL
- A4
- LETTER

A6(INTERNATIONAL 
POST CARD)

PAPER WEIGHT
- CUT SHEET
- ENVELOPE

PAPER CAPACITY
- CUT SHEET
- ENVELOPE
- LABEL
- TRANSPARENCY

210 ✕ 297 (8.3✕ 11.7”)

216 ✕ 279 (8.5✕ 11”)

216 ✕ 330 (8.5✕ 13”)

216 ✕ 356 (8.5✕ 14”)

191 ✕ 267 (7.3✕ 10.5”)

140 ✕ 216 (5.5✕ 8.5”)

176 ✕ 250 (6.9✕ 9.9”)

182 ✕ 257 (7.2✕ 10”)

148 ✕ 210 (5.8✕ 8.2”)

105 ✕ 148 

105 ✕ 241(4.12✕ 9.5”)
98 ✕ 191(3.87✕ 7.5”)
110 ✕ 220(4.33✕ 8.66”)
162 ✕ 229(6.38✕ 9.01”)
114 ✕ 162(4.49✕ 6.38”)

210 ✕ 297
216 ✕ 279(8.5✕ 11”)

210 ✕ 297
216 ✕ 279(8.5✕ 11”)

100 ✕ 148

●

●

●

●

●

●

●

16-24lb

500
(20lb)

●

●

●

●

●

● 

● 

●

●

●

●

16-24lb
16-20lb

500(20lb)
40(20lb)

●

●

●

●

●

● 

●

●

●

●

●

●

●

●

●

●

●

●

●

●

16-43lb
16-24lb

100  
10
25 
25 

●

●

●

●

20-24lb

Paper Paper size Tray1
Optional

Tray2
Multi-Purpose

Tray
Duplex

Acceptable paper size for all trays



Paper Specifications

The printer supports the following types of paper : 

Make sure the paper is good quality

• Plain
• Letterhead
• Bond
• Rough

• Prepunched
• Preprinted
• Color
• Recycled

• Transparency
• Labels
• Card Stock

Labels

To avoid damaging the printer, use only labels recommended for use in 

laser printers.

• The adhesive material should be stable at 400OF(205OC), the printer’s 

maximum temperature.

Transparencies

To avoid damaging the printer, use only transparencies recommended

for use in laser printers.

• Transparencies used in the printer must be able to withstand 

400OF(205OC), the printers maximum temperature.

Supported Types of Paper

Guidelines for Using Paper

SPECIFICATIONS A.5



Appendix

Macintosh User’s
Guide
You can use the printer to print a document from a Macintosh 
via a Serial LocalTalk interface or an optional network interface. 

Topics included in this appendix are:

◆ Setting Up Your Printer

◆ Installing Software

◆ Printing with a Macintosh

BB



MACINTOSH USER’S GUIDE B.1

Setting Up Your Printer

Installing Serial/LocalTalk Option Card

Installing Software

Installing Network Printer Card - PortThru (for Network Printing only)

Installing LaserWriter Printer Driver

For instructions on installing the Printer Options, 
see appendix F, “Installing Serial/LocalTalk or
Serial/IrDA option card”.

For instructions on installing the Printer Options,
see appendix F, “Network Option Card”. 

The following system requirements are necessary in
order to connect a Macintosh computer to the
printer.

• Mac OS 7.5 or higher
• Macintosh LaserWriter 8.x printer driver
• ML-7300 PostScript PPD

The LaserWriter 8 printer driver is standard to the
Mac OS 7.5 and higher. 
Check the Macintosh Chooser to assure that it is
installed. 
If it isn’t, use the Mac OS help system for
information about installing it.



MACINTOSH USER’S GUIDEB.2

Installing Software

Installing the PS Driver
Make sure the ‘READY’ message appears on the

operator panel display.

1 If necessary, press the power button on the
Macintosh computer.

2 Insert ML-7300 CD.

3 Select the correct language and double-click the
Installer icon. 
Then follow the  instructions on the screen.

4 From the Apple menu, choose Control Panel,
then double-click AppleTalk. 
The AppleTalk dialog box appears.

5 From the Connect Via drop-down list, 
select Printer Port if connecting with a LocalTalk
cable, or select Ethernet
if using a network connection.



6 From Chooser on the Apple menu, 
select LaserWriter 8.x icon. The name of your
printer appears in the right pane of the window. 
The name by default will be Samsung 010001
(Samsung followed by DDP address in
Hexadecimal).

B.3

Notes: If the computer is connected to a network, 

selecting Printer Port will disconnect
communication with the network. If you select
LocalTalk, the Samsung ML-7300 printer
appears in the Chooser box.

MACINTOSH USER’S GUIDE

Installing Software



7 Click on your printer name.

8 Click the Create button if it appears. 
The installation is completed. You don’t need
to proceed with the following steps.

9 Click on the Setup button. 

10 Select Auto Setup button. The Samsung 
ML-7300 file is installed automatically and
the Samsung ML-7300 printer icon appears
on the desktop.

11 Make sure the Samsung ML-7300 file is
installed correctly. Click on the OK button,
then close Chooser.

Notes: These steps appear with some driver
versions.

Important: If Auto Setup fails, 
click ‘Select PPD’ and choose
Samsung ML-7300 file.

Notes: Keep the original CD-ROM in a safe place.

Installing Software

MACINTOSH USER’S GUIDEB.4



1 Start the necessary application and open the
document you want to print.

2 From Chooser in the Apple menu, select
LaserWriter 8, then your printer name.

3 From the File menu, select Page Setup. The
Page Setup dialog box appears.

4 After making any necessary changes to the
page setup, click OK. 
See page Appendix B.6 for more information 
about Page Setup.

5 From File, select Print to open the Print
dialog box.

6 Make any necessary changes to the print
settings, then click Print.
See page Appendix B.8 for more information 
about Print settings.

7 Your printer starts printing.

Printing with a Macintosh

Printing from Macintosh

B.5MACINTOSH USER’S GUIDE



The Page Setup Dialog Box

When you select Page Setup from the File menu of your
application, a dialog box will appear.

Page Setup Features
Paper

: Select the paper size you want to use.

Layout
: Sets the number of pages to be printed on each sheet.

Reduce or Enlarge
: To print a reduced or enlarged copy of your document,

type a percentage of reduction or enlargement.

Orientation
: To set up your document so that it is oriented for

Portrait (tall) or Landscape (wide) printing, click one of
these icons.

Notes: The Page Setup dialog box may differ depending 
on the application and LaserWriter version you are
using.

Printing with a Macintosh

MACINTOSH USER’S GUIDEB.6



To display additional LaserWriter settings, click the Options
button. The window as shown below appears.

Visual Effects
Flip Horizontal

: To print a mirror image of the document, 
click this check box.

Flip Vertical
: To print the document upside down, 

click this check box.
Invert Image

: To print white area of the document as black and black
area as white, click this check box.

Printer Options
Substitute Fonts 

: To let the printer substitute fonts during printing, 
click this check box.

Smooth text 
: To improve printed bitmapped fonts, 

click this check box.
Smooth Graphics 

: To improve printed graphic images by smoothing jagged
edges, click this check box.

Precision Bitmap Alignment 
: To print improved bitmapped images, click this check box.

Larger Print Area (Fewer Downloadable Fonts) 
: To print on more of the page, click this check box.

Unlimited Downloadable Fonts In a Document 
: To use a large numberof Fonts in a document,  

click this check box.

Printing with a Macintosh
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When you select Print from the File menu of your
application, you will see the dialogue box as shown below.

Print Features
Copies

: Type the number of copies to be printed
Pages

: To print all your pages, click All.To print only some
pages, type the first page number in the From box
and type the last page number in the To box.

Paper Source
: Use these buttons and menus to select the paper

source you want to use.
Destination

: Use these buttons to send your document to the
printer or to save it as a PostScript file.

The Print Dialog Box

Notes: The Page Setup dialog box may differ depending 
on the application and LaserWriter version 
you are using.

Printing with a Macintosh
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To display additional printer settings, click the Options
button. The window as shown below appears.

Print Options Features

Cover Page
: Prints a cover page as the first or last page of the

document, or turns off the printing of a cover page.
Print

: Sets a document for printing in black and white, in
color, or shades of gray, or using ColorSync
matching or PostScript matching.

Print Profile
: Sets a document to be printed using the color

characteristics of a specific printer.
PostScript™ Errors

: Provides options for reporting PostScript errors 
that occur during printing.

Choose Resolution
: Selects print resolution.

Duplex
: Sets binding direction for duplex printing, 

or turns off duplex printing.

Printing with a Macintosh
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Appendix

Using Windows
PostScript Driver

Using Windows
PostScript Driver

If you want to use the PostScript driver provided with your

system CD-ROM or diskettes to print a document, use the

information in this Appendix.

Topics included in this Appendix are:

• Installing PS Driver

CC



USING WINDOWS POSTSCRIPT DRIVER C.1

Installing PS Driver

Important: • You must have the CD(or diskette) for “windows  95”
or Windows 98” available for use.

• You cannot use PS in Windows 3.1.

PPDs, in combination with the PostScript driver, access the
printer features and allow the computer to communicate
with the printer. An installation program for the PPDs is
provided on the ML-7300 CD-ROM. 

Notes:
• Installing the PostScript printer driver may require

the use of the operating system files on the original
CD-ROM or diskette that came with your system.

• If you have a PostScript level 3 driver and want to
use it, you must install the PostScript level 3 PPD
which is also provided on the ML-7300 CD-ROM.

1 Before installing PPD files, make sure that the printer and
the PC are properly connected with parallel or optional
network interface. For information on:

• Connecting with parallel interface, see page 2.8.
• Connecting with an optional network interface, 

see Appendix F, “Network Option Card”.

2 Insert the CD-ROM shipped with your printer into your
CD-ROM drive.

If the CD-ROM drive does not automatically run:

Select Run from the Start menu, and type
x:\cdsetup.exe in the Open box (where x is the
drive letter for the CD-ROM drive), then click OK.



USING WINDOWS POSTSCRIPT DRIVERC.2

3 When the opening screen appears, 
select the appropriate language. 

4 Click Install the Samsung Software-II on your
PC (PostScript).

5 Click on HaveDisk, click Browse, then choose:

• for Windows 9x, x:\Eng(or the desired language
code. See page 2.17)\ps\Win95_98\level 2.

• for Windows NT 4.0, x:\Eng(or the desired language
code. See page 2.17)\ps\WinNT\level 2.

• for Windows 2000, x:\Eng(or the desired language
code. See page 2.17)\ps\Win2000.

where x is the drive letter for the CD-ROM drive,
then click OK.

6 Follow the instructions on the screen to complete the
installation.

Installing PS Driver



Selecting the Default Printer

1 Start Windows on your pc.

2 Select Start ➔ Settings ➔ Printers from the 
Windows 95 task bar.

3 Double click the SAMSUNG ML-7300 PS 
printer icon.

4 Select File ➔ Default Printer.

5 Print the document on your Samsung ML-7300 PS.

1 Double-click on the PS driver icon.

2 Select Printer ➔ Properties.

3 Select the required options.

To set the PS driver features, proceed as follows 

Installing PS Driver
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Appendix

Using the Printer
on a Network
Using the Printer
on a Network

If you work in a networked environment, the printer can be
shared by other users on the network. ML-7300N printer is
a network printer and can be connected to the network via
direct attachment to an external print server. 
This appendix provides information on the following topics:

◆ About sharing the Printer on a Network

◆ Setting Up a Locally Shared Printer

◆ Setting Up a Network-Connected Printer

DD



USING THE PRINTER ON A NETWORK D.1

About Sharing the Printer on a Network
If you work in a networked environment, 
you can connect the ML-7300 series printer to your
network. 

You can connect the printer directly to a selected
computer (called the “host computer”) on the
network. The printer can then be shared  by other
users on the network through a Windows 9x, 2000
or NT 4.0 network printer connection.

If an option network card was installed on your
printer (see page Appendix F.8 for information on
installing the network option card in your printer)
or if you have ML-7300N printer, the printer can be
connected to the network via direct attachment to
an external print server. 

Whether the printer is locally connected or network
connected, you need to install the ML-7300 series
printer software on each computer that will print
documents to the ML-7300 series printer.

Locally Shared

Network-Connect

Printing Across a Network



1 Start Windows.

2 From the Start menu, select Control Panel, 
and double-click on the Network icon.

3 Check the File and Print Sharing box, then click OK.
Close the window.

4 Click Start and select Printers from Settings, 
then double-click your printer name.

5 Select Properties in the Printers menu.

6 Click the Sharing tab, then check the Shared As box. Fill
in the Shared Name field, then click OK.

1 Right-click Start, and select Explorer.

2 Open your network folder in the left column.

3 Right-click the shared name, and select Capture 
Printer Port.

4 Select the port you want, check the Reconnect 
at log on box, then click OK.

5 From the Start menu, select Settings, then Printers.

6 Double-click your printer icon.

7 From the Printers menu, select Properties.

8 Press the Details tab, select the printer port, 
then click OK.

Setting Up a Locally Shared Printer

USING THE PRINTER ON A NETWORKD.2

Setting Up Host Computer

Setting Up Client PC



Setting Up a Network-Connected Printer

To use the ML-7300 Series printer as a Network printer, 
you must install an optional network card in your printer. 
See page F.8 for information on installing the network card. 
If you have an ML-7300N printer, you do not need to install 
the network card. The Samsung ML-7300N printer is shipped
with the network card.

After the network card is installed, you must set up 
your printer as a network printer using the documentation and
Samsung SyncThru software provided with the network card.

USING THE PRINTER ON A NETWORK D.3
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Installing
Software from
Diskettes

Installing
Software from
Diskettes

If you need to install the printer software on a system 
that does not have a CD-ROM drive, use the instructions in
this appendix to create the software diskettes and install 
the printer software from the diskettes.

This appendix provides information on the following topics:

◆ Making Installation Diskettes

◆ Installing Software from Diskettes

EE



INSTALLING SOFTWARE FROM DISKETTES E.1

Making Installation Diskettes

If you do not have a CD-ROM drive and if you have access
to another computer with a CD-ROM drive, you can copy
software installation files from the your printer software 
CD-ROM onto floppy diskettes, then use the diskettes
instead of the CD-ROM to install the software.

You can make the installation diskettes for PCL 6 driver,
PostScript Driver. Make sure that you have several
formatted diskettes ready, then follow these steps:

1 Insert the ML-7300 CD-ROM into the CD-ROM drive.
Install will start automatically.

If the CD-ROM drive does not automatically run:

Select Run from the Start menu, and type
x:\cdsetup.exe in the Open box (where x is the drive
letter for the CD-ROM drive), then click OK.

2 When the opening screen appears, 
select the appropriate language.

3 Click Make your own Diskette set of software.



INSTALLING SOFTWARE FROM DISKETTESE.2

4 The Copy to Floppy dialog box appears.

Select the desired components you want to copy to the
diskette from the Select box. You can select PCL Printer
Driver, PostScript Driver.

Select the floppy disk drive you will use to 
insert the diskette. 

5 Click Copy all disk images.

If you want to copy a portion of the selected component,
select the disk you want to copy in the Disk Images
window, then click Copy selected disk image. 

6 When prompted, insert a blank, formatted diskette into
the floppy drive, and click Yes to copy the first diskette.
For multiple diskettes, when the first diskette is finished,
you are prompted to insert disk 2.

Make sure you label each diskette in order as you create it:
PCL Printer Driver, disk 1 of 2, etc.

Shows the 
path of the

selected
component.

Select the
floppy drive you

will use.

Making Installation Diskettes

Shows the 
number of disks
required to copy

the selected
component. 

Select the
component you
want to copy.



The instructions to install PCL Printer Driver, PostScript
Driver are same. Take the following steps:

1 Insert the first diskette (if the selected software diskettes
are more than one) which contains the desired
installation software; PCL Printer Driver, PostScript Driver.

2 From the Start menu, select Run. 

3 Type A:\setup.exe in the Open box and click OK. 
(if your floppy drive is not A, substitute the correct
letter).

4 Follow the on-screen instructions to complete the
installation.

7 If you have more than one disk, insert the next disk and
click Yes. Repeat this step for a third disk if necessary.

8 When the diskettes have finished copying, click Close in
the Copy to Floppy dialog box. Then click Exit in the
SAMSUNG PRINTER SETUP dialog box.

Installing Software from Diskettes

Making Installation Diskettes

INSTALLING SOFTWARE FROM DISKETTES E.3



Appendix

Printer OptionsFF Printer Options
Your printer is a full-featured laser printer that has been
optimized to meet most of your printing needs. Recognizing
that each user may have different requirements, however,
Samsung makes several options available to enhance the
printer’s capabilities.

This appendix provides information on the following topics:

◆ Precautions

◆ Preparations

◆ Closing The Printer Cover

◆ Understanding the Printer Control Board

◆ Printer Memory

◆ Network Option Card 

(Installed in ML-7300N already)

◆ Installing Serial/LocalTalk or 

Serial/IrDA option card

◆ Serial/LocalTalk

◆ Serial/IrDA

◆ Optional Tray 2



PRINTER OPTIONS F.1

Precautions

Never remove the printer control board while the printer is
plugged in.

To avoid the possibility of electrical shock, always disconnect the
power cord when installing or removing ANY internal or external
printer option.

The control board and internal printer options 
(SIMM, Network interface) are sensitive to static electricity. 
Before installing or removing an internal option, 
discharge static electricity from your body by touching
something metal, such as the metal back plate on any device
plugged into a grounded power source. 
If you walk round before finishing the installation, discharge any
static electricity again.

Discharge Static Electricity

Disconnect The Power Cord
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Preparations

3 Remove the printer cover. 
a Open the rear cover.
b Remove the two screws from

the back of the printer. 
Save the screws.

c Grasp the cover
(as illustrated) and pull it
firmly toward the rear of the
printer until it stops. 

d Remove the cover from the
printer.

Complete the following steps before you install the printer options.

1 Unplug the printer power cord.

2 Disconnect all cables from the back of the printer.

e Remove the five screws from
the metal plate covering the
control board.

f Remove the plate.
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Closing The Printer Cover
When you have finished installing an Option, follow these steps.

1 Close the metal plate and tighten
all the screws.

2 Set the bottom of the cover onto
the printer. Make sure the bottom
tabs on the cover fit into the
corresponding slots in the printer.
Rotate the cover up towards the
printer. Slide the cover toward the
front of the printer until it clicks
into place.

3 Gently tighten all the screws.

4 Reconnect any interface cables and the power cord. 
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Network Card
Connector

Serial/LocalTalk 
or Serial/IrDA
Connector

If the printer cover is opened, 
you can see the printer control board as below.

Printer Memory
Connector

ROM SIMM
Connector

Understanding the Printer Control Board
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Printer Memory

2 Remove two screws and remove the metal plate in the direction 
of the arrow.

CN 4: This slot recognizes only half of 8MB,
32MB and 128MB SIMMs if they are installed. 

Memory
Connector

CN 3

CN 4

CN 5

The printer memory option increases the printer’s 
dynamic random access memory (DRAM).
Your printer was shipped with 16MB of standard printer Memory.
You can install two printer memory options in your printer. Printer memory upgrade
options available are 4, 8, 16, 32, 64 and 128MB.

Notes: Your machine recognizes only half of 8MB, 32MB and 128MB SIMMs 
if installed in the slot CN 4.

DRAM SIMM Features for Upgrade
- Speed(Access Time): 50nS
- Refresh Time: 1K(1024 cycles/16 ms) / 2K(2048 cycles/32 ms)
- The Method of refresh is CAS-befor-RAS refresh
- Mode: EDO Type
- Single +5V +/-10% power supply
- The SDRAM does not support

1 Before you install the printer memory option, follow steps under 
‘Preparations’ on page F.2.

Notes: The printer memory option is easily damaged by static electricity. 
Touch something metal before you touch the memory option.
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4 Hold the memory option with the
connection points pointing toward
the connector and position the
notch as shown. Insert the
memory option all the way into
the connector at a 30O

angle, and rotate it left until it
snaps into place.

5 Make sure both metal clips on the
connector are fastened, and the
two pins on each of the
connectors are pushed through
the holes on the memory option.

6 Continue with ‘Closing the Printer
Cover’ on page F.3.

7 Set the printer memory item on
the printer tab of the properties 
dialogue box to the value of the
added printer memory.

Notch

Connection points

Printer Memory

3 Unpack the memory option.

Notes: Avoid touching the connection
points along the edge. 
Save the packaging.
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Printer Memory

1 Push the metal clips at each end
of the connector away from
memory option.

2 Rotate the memory option right
to a 30O angle and gently pull it
out of the connector as shown.

Complete the following steps if you need to remove a printer memory
option before you install a new one.

Notes: If you did not save the packaging, wrap the memory option in
paper and store it in a box.

3 Place the printer memory option in its original packaging.

Removing the Printer Memory Option
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Network Option Card

When unpacking the network printer card, 
you should find the following items. 

Network Printer Card
(PortThru)

Network Brackets

Network Management
S/W User’s Guide

CD-ROM(SyncThru)

For ML-7300 Series

Overview
This chapter describes the proper preparations for network
printing. It contains the following information:

• Package Contents
• Installing Procedure
• Connecting a Printer to the Network
• Powering Up

Package Contents

Items Supplied

Notes: Before installing the PortThru card to your printer, 
you should attach one of the brackets above by using two
screws provided according to the type of your printer model.
You can check it with the picture of page F.9 which shows the
attached bracket to the PortThru card for ML-7300 Series.
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Network Option Card

The network option card lets you connect the printer to a local area
network(LAN).You can install one network option card in your printer.

Card Connector Points

RJ-45 Port(Ethernet
10/100 Base T network)

Installing Procedure

1 Before you install the network option card, follow steps 
under ‘preparations’ on page F.2.

2 Locate the card connector 
on the printer control board.

Network card
connector



5 Align the connector on the card
with the connector on the printer
control board. Push the card firmly
into the connector until it is
completely in place.

Result: The two connectors should fit
snugly together.

PRINTER OPTIONSF.10

3 Remove the two screws from the
metal plate covering the opening
for cable connector. 

Remove the plate. 

4 Unpack the option card.

6 Gently tighten the screws to secure the card to the system board.

7 Continue with ‘Closing the Printer Cover’ on page F.3.

8 Install the network printer driver(called SyncThru) provided on
the CD-ROM. See Network Management Software User’s Guide for
installation.

Network Option Card
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Notes:
• The top green LED comes on when the cable is connected to the port on

the Network  Printer Card.
• After booting, the bottom green LED should blink irregularly and the top

green LED should come on continuously. If the bottom green LED blinks
regularly, turn on your printer again.

Connecting a Printer to the Network
Use standard network cabling that is used for other network components.
Make sure the printer is turned off before connecting the network cable to the port.

Attach the twisted-pair network cable to the RJ-45 port (10/100 Base T) on the card.

Powering Up

1 Connect the printer power cable into a properly grounded electrical outlet.

2 Turn on the printer.

top green 
LED

bottom 
green LED 

Network Option Card
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Installing Serial/LocalTalk 
or Serial/IrDA option card

3 Remove the single screw that
fastens the metal plate covering
the cable connector opening.

4 Remove the plate.

5 Insert the Serial/LocalTalk or
Serial/IrDA option card into the
option card slot.

2 Locate the Serial/LocalTalk or Serial/IrDA connector on the printer
control board.

1 Before you install the Serial/LocalTalk or Serial/IrDA option card, 
follow steps under ‘Preparations’ on page F.2.



Installing Serial/LocalTark or Serial/IrDA option card

PRINTER OPTION F.13

7 Push the card firmly into the connector until it is completely in place.

8 Gently tighten the screws to secure the card to the system board.

9 Continue with ‘Closing the Printer Cover’ on page F.3.

6 Align the connector on the card
with the connector on the printer
control board.

Notes: The two connectors should fit snugly together.
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Connect the printer to your Macintosh using a LocalTalk cable.

Notes : A LocalTalk cable is not included. 

It must be purchased separately. 

Please contact your Macintosh dealer.

Connecting the LocalTalk Cable

Serial/LocalTalk
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You can use an infrared adapter to print remotely from an IrDA-Compatible
computer equipped with an infrared port.

The infrared port is compliant with the specifications established by the
Infrared Data Association(IrDA).

The infrared port operates transmitting data at speeds up to 115.200
bits per second.

1 Make sure the printer power
cord is unplugged.

2 Locate the infrared port 
on the back of your printer.

3 Plug the adapter cable into the
infrared port.

4 Reconnect the power cord.

Result: The green light on the infrared adapter comes on 
when the printer is plugged in.

Serial/IrDA

Connecting the Infrared Apapter
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Serial/IrDA

1 To print with an infrared port, you should install an infrared port driver
on your computer.
● If you do not have the driver, please ask your PC manufacturer.
● You can download the infrared driver for Windows 95 from the internet 

with no charge (http://www.microsoft.com).

2 Aim the computer infrared port at the infrared port on the back 
of the printer.

3 Aim the infrared port on your computer within 15 degrees of 
either side of the line as shown.

4 The printer must be within 3 feet(1 meter) of the computer.

5 Make sure the printer is in ready state.

6 Send the print job from the computer.

Using the Infrared Apapter
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Optional Tray 2

You can install an Optional Tray 2 Complete the following steps beforeyou 
install the Optional Tray 2. 

● Unplug the printer power cord.
● Disconnect all cables from the back of the printer.

1 Carefully place the printer on
top of the Optional Tray 2 unit.
● Make sure the connector is

properly inserted.

2 Reconnect all cables to the back of the printer.

3 Reconnect the power cord to the printer.

4 Make sure the ‘READY’ message appears on 
the operator panel display.
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Optional Tray 2

Your printer has an optional cassette that can hold up to 500 sheets of 
paper or 40 envelopes.

To load paper in the Optional Tray 2, proceed as follows.

1 Pull the tray completely 
out of the printer.

2 Press down on the bottom plate
to lock it into position.

Notes: To load the envelope into the
tray, lift the lever on the left
side of the tray.

Loading the plain Paper into the Optional Tray 2
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Optional Tray 2

3 Squeeze and lift the length
guide and slide it to the desired
paper size until it clicks into
place.

4 Lift the width guide on the paper
guide to the desired paper size
until it clicks into place.
The paper size is indicated on the
bottom of the Optional Tray 2.

6 Place the paper against the left
of the rear paper guide.

5 Squeeze the width guide and slide
it to the right side of the Tray.
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7 Squeeze the width guide and
slide it to the right and left until
it touches the edge 
of the paper.

Notes: ●  Do not fold or crease the paper.
●  This mark indicates the height of

paper loaded.

Notes: The printer may pull paper from tray 1 first. 
To change this, see ‘Paper Source Selection’ on page F.22.

Optional Tray 2
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Optional Tray 2

1 Lift the lever
on the left
side of the
Tray.

2 Press down on 
the bottom plate
to lock it into
position.

3 Lift the width guide and 
slide it to the envelope 

size indicated
on the bottom.

4 Lift the length guide and
slide it to the envelope

size indicated 
on the 
bottom.

5 Place the envelopes
against  the left side of
the Tray. Squeeze the
envelope guide  lever
and slide it to the left 
until it touches the edge 
of the envelopes.

6 Squeeze the width
guide and slide it
to the right and
left until it touches
the edge of the
envelopes.

Loading the envelopes into the Optional Tray 2
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Optional Tray 2

Use PCL driver to select the tray you wish to print.

1 Select Start ➔ Settings ➔ Printers from the windows task bar.

2 Click on the Samsung ML-7300 PCL 6 icon.

3 Select Files ➔ Properties.

4 Click on the Paper tab. 

5 Set the source item to Default Value or Optional Tray 2.

Click

Notes: Settings in the printer driver and software application override
operator panel settings.

Paper Source Selection



Optional Tray 2

2 Press the Menu > or < buttons one 
or more times until ‘Printing Menu’ is
displayed.

3 Press the Item < or > buttons one or
more times until ‘Tray’ appears on the
display.

4 Press the Value + or - buttons one or more
times to select ‘OPT’.

5 Press the Enter button.

● An asterisk(❊ ) appears beside the
current user default setting for that
menu item. 

You can select a paper source by setting the TRAY item using the control

panel menu.

If you do not use printer driver. To Select Optional Tray 2 as the default setting: 

1 Press On Line.

Result: The OFFLINE message appears on 
the display and the printer is off-line.

PRINTER OPTION F.23



Appendix

Using your
Printer in Linux

You can use Samsung ML-7300 Series printer in Linux

environment.

This appendix provides information on the following topic:

• Linux Driver Installation

GG



Linux Driver Installation

USING YOUR PRINTER IN LINUX G.1

This Linux driver is designed for Samsung ML-7300 Series
printer and supports Linux Red Hat 6.0 or higher and Intel
Linux. If your Linux version is not included, this driver might
not work properly.

• Install Setup Script file configuration
a. /cdrom/linux/install.sh
b. /cdrom/linux/ssprt.db
c. /cdrom/linux/readme.txt

To install the driver, open the x terminal screen and take the
following steps:

Installation

To mount the CD-ROM drive:

1 Insert the Samsung ML-7300 Series CD-ROM into the
CD-ROM drive.

2 Mount the CD-ROM drive under a directory like /mnt in
order to access the files on the CD-ROM: 
>mount -t iso9660 /dev/cdrom /mnt/cdrom

Notes: To mount the CD-ROM drive, you must be a super
user or must be authorized to mount the CD-ROM by the
super user. If you fail to mount the CD-ROM drive, ask the
system administrator.

1. Mount the CD-ROM
drive.

2. Install setup script. For details on installing the setup script, refer to the
/cdrom/linux/readme.txt file.

Add the driver to the printer list by typing in:
/cdrom/linux>install.sh (or)
/cdrom/linux>./install.sh (if the path of the current
working directory is not determined).
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Linux Driver Installation

3. Set up the printer filter. To set up:

1 Run printtool at x terminal.

2 To add the printer driver, click the Add button.

3 In the Add a Printer Entry window, decide the printer
type you will use. Select Local Printer if you have a PC-
connected printer.

4 Click the OK button.

5 If the Info button appears, ignore it, then click the OK
button.

6 The Edit xxxx Entry window opens (where xxxx is the
printer type you have selected at step 3).

If you are not an advanced user, do not change the
Names/Spool Directory/File Limit in Kb/Printer
Device option.

7 Click the Select button in the Input Filter to access
filter setup.

8 Select Samsung Printer PCL 5e Compatible for the
Printer Type item. Then select the default resolution and
paper size.

9 To save the setting, press the OK button.

10 In the Edit xxxx Entry window, press the OK button to
complete the printer driver installation.

11 You can find that the printer driver is added to the
driver window. Select Quit from the PrintTool menu.
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MemoMemo
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